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Preface

This publication is for the customer who is installing and/or operating the Virtual 
Operator Panel (VOP), whenever a Service Delivery Platform (SDP) is not present. 

Note – When an SDP site server unit is installed on site, monitoring installed drives via 
an Ethernet private network, the drive Ethernet port is 100% dedicated to the SDP. 
Therefore, the drive Ethernet port is NOT available for customer connection, required 
for VOP interface with the drive. 

Organization
The organization of this guide is: 

 

Chapter 1 “Virtual Operator Panel Overview” provides an overview and prerequisite 
information regarding the virtual operator panel. 

Chapter 2 “Software Installation” provides guidelines for installing Java Runtime 
Environment, and the virtual operator panel application software. 

Chapter 3 “Starting VOP Programs” provides guidelines for starting the virtual 
operator panel application.

Chapter 4 “VOP Operation - T-series” provides guidelines for using the virtual operator 
panel to interface with a T10000 or T9840D tape drive. 

Chapter 5 “VOP Operation - LTO” provides guidelines for using the virtual operator 
panel to interface with an LTO Generation 4 tape drive.

Appendix A “Changing the Computer IP Address” provides guidelines for setting static 
IP address, and resetting for dynamic IP address.

Appendix B “VOP to Drives on Private Networks” provides guidelines for configuring 
drives in the multi-drive environment with the VOP.

Glossary The “Glossary”defines some terms and abbreviations used in this guide. 

Index The “Index” provides an additional means of locating information within this 
document. 
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Additional Information
This section offers several methods to obtain additional information. 

Sun’s External Web Site 
Sun’s external Web site provides marketing, product, event, corporate, and service 
information. The external Web site is accessible to anyone with a Web browser and an 
Internet connection.

The URL for the  external Web site is: http://www.sun.com

The URL for StorageTek™ brand-specific information is: 
http://www.sun.com/storagetek/

Related Documentation

Documentation, Support, and Training

Document Title Part Number

T10000 Tape Drive Operator’s Guide 96174

T9x40 Tape Drive User’s Reference Manual 95739

Crypto Key Management Station Configuration and Startup Guide 96261

 Crypto Key Management Station User’s Guide 96262

Sun Function URL

Documentation http://www.sun.com/documentation/ 

Support http://www.sun.com/support/

Training http://www.sun.com/training/

http://www.sun.com
http://www.sun.com/storagetek/
http://www.sun.com/documentation/
http://www.sun.com/training/
http://www.sun.com/support/
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Internal Code License Statement

The following is the Internal Code License Agreement from StorageTek:
NOTICE

INTERNAL CODE LICENSE
PLEASE READ THIS NOTICE CAREFULLY BEFORE INSTALLING AND OPERATING THIS EQUIPMENT. THIS 
NOTICE IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR ENTITY), THE END USER, 
AND STORAGE TECHNOLOGY CORPORATION (“STORAGETEK”), THE MANUFACTURER OF THE 
EQUIPMENT. BY OPENING THE PACKAGE AND ACCEPTING AND USING ANY UNIT OF EQUIPMENT 
DESCRIBED IN THIS DOCUMENT, YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. 
IF YOU DO NOT AGREE WITH THE TERMS OF THIS AGREEMENT, DO NOT OPEN THE PACKAGE AND USE 
THE EQUIPMENT. IF YOU DO NOT HAVE THE AUTHORITY TO BIND YOUR COMPANY, DO NOT OPEN THE 
PACKAGE AND USE THE EQUIPMENT. IF YOU HAVE ANY QUESTIONS, CONTACT THE AUTHORIZED 
STORAGETEK DISTRIBUTOR OR RESELLER FROM WHOM YOU ACQUIRED THIS EQUIPMENT. IF THE 
EQUIPMENT WAS OBTAINED BY YOU DIRECTLY FROM STORAGETEK, CONTACT YOUR STORAGETEK 
REPRESENTATIVE. 

1. Definitions: The following terms are defined as 
follows:
a. “Derivative works” are defined as works based 

upon one or more preexisting works, such as a 
translation or a musical arrangement, or any other 
form in which a work might be recast, transformed, 
or adapted. A work consisting of editorial revision, 
annotations, elaboration, or other modifications 
which, as a whole, represent an original work of 
authorship, is a Derivative work.

b. “Internal Code” is Microcode that (i) is an integral 
part of Equipment, (ii) is required by such 
Equipment to perform its data storage and retrieval 
functions, and (iii) executes below the user interface 
of such Equipment. Internal code does not include 
other Microcode or software, including data files, 
which might reside or execute in or be used by or in 
connection with such Equipment, including, 
without limitation, Maintenance Code.

c. “Maintenance Code” is defined as Microcode and 
other software, including data files, which might 
reside or execute in or be used by or in connection 
with Equipment, and which detects, records, 
displays, and/or analyzes malfunctions in the 
Equipment.

d. “Microcode” is defined as a set of instructions 
(software) that is either imbedded into or is to be 
loaded into the Equipment and executes below the 
external user interface of such Equipment. 
Microcode includes both Internal Code and 
Maintenance Code, and might be in magnetic or 
other storage media, integrated circuitry, or other 
media.

2. The Equipment you have acquired by purchase or 
lease is manufactured by or for StorageTek and 
contains Microcode. By accepting and operating this 
Equipment, you acknowledge that StorageTek or its 

licensor(s) retain(s) ownership of all Microcode, 
as well as all copies thereof, that might execute 
in or be used in the operation or servicing of the 
Equipment and that such Microcode is 
copyrighted by StorageTek or its licensor(s).

3. StorageTek hereby grants you, the end user of the 
Equipment, a personal, nontransferable (except as 
permitted in the transfer terms below), nonexclusive 
license to use each copy of the Internal Code (or any 
replacement provided by StorageTek or your 
authorized StorageTek distributor or reseller) which 
license authorizes you, the end user, to execute the 
Internal Code solely to enable the specific unit of 
Equipment for which the copy of Internal Code is 
provided to perform its data storage and retrieval 
functions in accordance with StorageTek’s (or its 
licensor’s) official published specifications.

4. Your license is limited to the use of the Internal Code 
as set forth. You might not use the Internal Code for 
any other purpose. You might not, for example, do 
any of the following:

(i) access, copy, display, print, adapt, alter, 
modify, patch, prepare Derivative works of, 
transfer, or distribute (electronically or 
otherwise) or otherwise use the Internal Code;
(ii) reverse assemble, decode, translate, 
decompile, or otherwise reverse engineer the 
Internal Code (except as decompilation might be 
expressly permitted under applicable European 
law solely for the purpose of gaining 
information that allows interoperability when 
such information is not otherwise readily 
available); or
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(iii) sublicense, assign, or lease the Internal Code 
or permit another person to use such Internal 
Code, or any copy of it.

5. Nothing in the license set forth above or in this entire 
Notice shall convey, in any manner, to you any license 
to or title to or other right to use any Maintenance 
code, or any copy of such Maintenance Code. 
Maintenance Code and StorageTek’s service tools and 
manuals might be kept at your premises, or they 
might be supplied with a unit of Equipment sent to 
you and/or included on the same media as Internal 
Code, but they are to be used only by StorageTek’s 
customer service personnel or those of an entity 
licensed by StorageTek, all rights in and to such 
Maintenance Code, service tools and manuals being 
reserved by StorageTek or its licensors. You agree that 
you shall not use or attempt to use the Maintenance 
Code or permit any other third party to use and access 
such Maintenance Code.

6. You, the end user, agree to take all appropriate steps 
to ensure that all of your obligations set forth in this 
Notice are extended to any third party having access 
to the Equipment.

7. You might transfer possession of the Internal Code to 
another party only with the transfer of the Equipment 
on which its use is authorized, and your license to use 
the Internal Code is discontinued when you are no 
longer an owner or a rightful possessor of the 
Equipment. You must give such transferee all copies 
of the Internal Code for the transferred Equipment 
that are in your possession, along with a copy of all 
provisions of this Notice.

Any such transfer by you is automatically 
(without further action on the part of either 
party) expressly subject to all the terms and 
conditions of this Notice passing in full to the 
party to whom such Equipment is transferred, 
and such transferee accepts the provisions of this 
license by initial use of the Internal Code. You 
cannot pass to the transferee of the Equipment 
any greater rights than granted under this 
Notice, and shall hold StorageTek harmless from 
any claim to the contrary by your transferee or 
its successors or assigns. In addition, the terms 
and conditions of this Notice apply to any copies 
of Internal Code now in your possession or use 
or which you hereafter acquire from either 
StorageTek or another party.

8. You acknowledge that copies of both Internal Code 
and Maintenance Code might be installed on the 
Equipment before shipment or included with the 
Equipment and other material shipped to you, all for 
the convenience of StorageTek’s service personnel or 
service providers licensed by StorageTek, and that 
during the warranty period, if any, associated with the 
Equipment, and during periods in which the 
Equipment is covered under a maintenance contract 
with StorageTek or service providers licensed by 
StorageTek, both Internal Code and Maintenance Code 
might reside and be executed in or used in connection 
with such Equipment, and you agree that no rights to 
Maintenance Code are conferred upon you by such 
facts. 

StorageTek or the licensed service provider 
might keep Maintenance Code and service tools 
and manuals on your premises but they are to be 
used only by StorageTek’s customer service 
personnel or those of service providers licensed 
by StorageTek. You further agree that upon  
(i) any termination of such warranty period or 
maintenance contract period; or  
(ii) transfer of possession of the Equipment to 
another party, StorageTek and its authorized 
service providers shall have the right with 
respect to the affected Equipment to remove all 
service tools and manuals and to remove or 
disable all Maintenance Code and/or replace 
Microcode which includes both Internal Code 
and Maintenance Code with Microcode that 
consists only of Internal Code.
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CHAPTER 1

Virtual Operator Panel Overview

Introduction
The Virtual Operator Panel (VOP) is a computer-based Graphical User Interface (GUI) 
that you can use to communicate with a T10000 tape drive, a T9840D tape drive, or a 
Linear Tape Open (LTO) generation 4 tape drive manufactured by Hewlett-Packard to 
monitor drive operations, perform cartridge operations, and complete several other 
functions that will be described in other chapters of this guide.

When you have connected your PC to the tape drive or library drive tray Ethernet port, 
the VOP provides an intuitive and user-friendly GUI to display drive-related 
information, configure the drive, or perform various drive operations and functions. 
There are two versions of the VOP:

■ T-series (supports T10000A, T10000B, and T9840D tape drives)

■ LTO-4 (currently supports only the Hewlett-Packard drive)

Prerequisites 
Before you can install and operate the VOP application, your system must meet certain 
prerequisites. There are minimum hardware requirements, operating system 
certification, and Java Runtime Environment minimum release level requirement.

Computer Hardware Requirements 
Minimum hardware requirements for the VOP application:

■ 512 MB memory 
■ 1.0 GHz processor 
■ Monitor screen resolution 1024 x 768
■ Ethernet port available for static IP addressing
■ RJ45-RJ45 Ethernet cross-over cable (direct connection to drive) 
■ RJ45-RJ45 Ethernet cables (indirect connection through an Ethernet switch)

Note – See Appendix B for indirect Ethernet connection guidelines.
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Operating System Certification 
The following operating systems are certified for VOP: 

■ Linux–Redhat 9.0, ES 
■ Solaris–SunOS 5.8, SunOS 5.9, and SunOS 5.10
■ Windows 2000 or XP 

Note – Platforms with older operating systems likely do not meet the minimum 
hardware requirements (see “Computer Hardware Requirements”).

Java Runtime Environment Requirement 
The VOP software application is a Java-based program. Therefore, you need a 
compatible version of Java Runtime Environment (JRE) installed on your computer. 

Note – Your computer must have version JRE 1.5, or higher, to properly install and run 
VOP release 1.0.10, or higher.

Before attempting to install and run VOP, verify the presence, and release level of JRE. 
On Windows OS, open the Control Panel, and double-click Add and Remove Programs.  
On Linux/UNIX OS, see your system administrator.

Ethernet Connection to the Drive
To interface with a drive using VOP, you must have an Ethernet connection from your 
computer to the Ethernet port on the tape drive or drive tray rear panel. 

■ Direct to the drive: You must use a single crossover Cat-5 Ethernet cable.

■ Indirect (through an Ethernet switch): You must use a straight Cat-5 Ethernet cable 
to connect your computer to the switch. The switch-to-drive cable should already be 
connected.

Note – See Appendix B, “VOP to Drives on Private Networks” for additional 
guidelines when connecting through an Ethernet switch.

Also, your computer must be configured with a static IP address, compatible with the 
target drive. 

Note – See Appendix A, “Changing the Computer IP Address” for guidelines.

When you have Ethernet connection to a drive, and a compatible static IP on your 
computer, you are ready to operate VOP.
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VOP Application Window (T-series)
The VOP application opens within its own window on a computer display screen.  
FIGURE 1-1 depicts the VOP (Windows OS) after connection to a drive. 

■ The menu bar contains the names of the online and offline menus. The File and Help 
menus are the only available menus before you connect to a drive. The Drive 
Operations, Retrieve, and Configure (drive must be offline) menus have expanded 
sub-menus and commands available only when VOP is connected to a drive.

■ The drive name area displays the drive IP (10.0.0.1 in this example). 

■ The primary drive message window shows a recently loaded encryption key. 

■ The VOP text message pane displays the VOP transcript, from the connection 
initiation to the time the screen was captured.

■ The drive status indicators show that a cartridge is not loaded; the drive is online; 
the drive is in need of a cleaning cartridge operation; the optional heartbeat is 
enabled; and that the drive is encryption-enabled (see TABLE 1-1 on page 26 for 
complete drive status indicator states).

Note – VOP on the Linux or UNIX OS is similar, but with a Linux/UNIX look and feel.

Note – See Chapter 4, “VOP Operation - T-series” for details about VOP menus.

FIGURE 1-1 T-series VOP Application Window  

1. Menu bar 
2. Drive IP/name 
3. Primary drive message window 
4. Secondary drive message window 
5. VOP transcript pane 
6. Drive status indicators 
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Drive Status Indicators 
When you connect VOP to a drive, the drive status indicators (FIGURE 1-2) change color 
to indicate different drive conditions. You can click on certain indicators, such as 
Online, to toggle the drive to the alternative condition, and the label changes 
accordingly.

TABLE 1-1 describes the VOP status indicators, including the color meanings. 

FIGURE 1-2 Drive Status Indicators 

TABLE 1-1 Drive Status Indicators  

Indicator Color Meaning

All Black Indicates no connection to a tape drive

Loaded 
Unload 
 
 
Empty

Blue 
Grey 
 
Magenta 
Grey

Indicates that a cartridge is loaded in the drive 
Indicates that a cartridge is present in the loading slot,  
but NOT loaded in the drive 
Indicates cartridge loading/unloading is in transition 
Indicates that a cartridge is NOT present in the loading slot

Online 
Offline

Blue 
Grey 
Magenta

Indicates that the drive is online (label reads “Online”) 
Indicates that the drive is offline (label reads “Offline”) 
Indicates online/offline is in transition

Clean Orange Indicates that the drive needs to be cleaned 

Dump Orange Indicates that there is an un-retrieved dump present 

Heart 1 Blue/grey Alternates blue/grey (1 cps) while the VOP-to-drive connection is 
active. 
Note: The Heart indicator is available in VOP 1.0.9 or earlier only.

Encryption 2 Red Indicates that the drive is encryption-enabled and has all keys (label is 
Enabled).

Orange Indicates the drive is missing an encryption key (label indicates Media 
for KMS 2.0) or that the drive has not been enrolled (label indicates 
No Ecpt for KMS 2.0)

1. The heart indicator is present only when the “-b” (heartbeat feature) parameter is set in the VOP batch file. The 
heart beat indication is optional.

2. The encryption status indicator is present only with an encryption-capable drive that is encryption-enabled.
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Help Menu 
The Help menu (FIGURE 1-3) contains a single command.

About 

The Drive About Dialog box appears when you select About. It provides basic 
information about the VOP, such as VOP version and build date, and the Java Runtime 
Environment version. The actual Drive Name and Drive IP Address information is 
displayed only when the VOP is connected to a drive. The Drive Type shows the drive 
models on which you can use the VOP version.

Note – The VOP title bar shows Virtual Operator Panel when there is no connection to 
the drive for those VOP versions that support multiple drive models. When a drive 
connection is completed, the title bar indicates the drive mode (such as T10000A Virtual 
Operator Panel).

FIGURE 1-3 VOP Help Menu 
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LTO-4 VOP Application Window
The LTO-4 VOP application opens within its own window on a computer display 
screen. FIGURE 1-4 depicts the VOP (Windows OS) after connection to a drive. 

■ The title bar displays the drive IP (10.0.0.1). 

■ The Connect button is blue. 

■ There are four drive status indicators: Online, Empty, Service, and Encrypt.

■ Three panels are available: Monitor Drive, Configure Drive, and Diagnose Drive. 

Note – VOP on Linux or UNIX OS is very similar, but with a Linux/UNIX look and 
feel.

See Chapter 5, “VOP Operation - LTO”for additional information.

FIGURE 1-4 LTO-4 VOP Application Window 
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CHAPTER

 

2

Software Installation

This chapter provides instructions to install/update Java Runtime Environment (JRE) 
and the Virtual Operator Panel (VOP) Customer version application. 

Install the Java Runtime Environment 
To install/update Java Runtime Environment, go to http://www.sun.com.

Note – The Sun.com web pages are dynamic, and subject to frequent changes. 
Therefore, the actual pages you see might differ from the examples in this section 
(FIGURE 2-1 through FIGURE 2-4 on page 31). However, you should be able to make 
appropriate selections. Read the prompt text carefully before making selections.

1. Choose Java 2 Standard Edition from the Downloads menu.

A page containing all available Java SE downloads opens (FIGURE 2-2 on page 30).

FIGURE 2-1 Sun.com Home Page

www.sun.com
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2. Make sure the Latest Release section is active. If not, click it.

Note – The list of the latest release of Java SE downloads is rather long; therefore, all 
but the Java Runtime Environment has been removed from the illustration. 

3. Click Download to start the JRE download.

A list of available platform versions and the License Agreement appears (FIGURE 2-3).

Note – You must Accept the License Agreement to download any selection.

FIGURE 2-2 Java SE Downloads

FIGURE 2-3 Java License Agreement
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After you accept the License Agreement, select the platform version to match the 
operating system of your PC, and select offline/online installation (FIGURE 2-4). Offline 
installation saves a large executable file that you run after exiting Sun.com. Online 
installation saves a small executable file that you must run while still online.

Note – There are several additional platform selections available than are shown in 
FIGURE 2-4. Review the complete list before making your selection.

4. Select the appropriate check box, then click the adjacent link.

If you selected offline installation, you are prompted to specify the location for the large 
executable installation file. You can then exit Sun.com.

If you selected online installation, a small installer executable file is saved to your 
desktop. You should remain online to Sun.com until the installation is finished.

5. Double-click the executable file to start the installation process.

The installation process takes several minutes, and requires you to respond to a few 
prompts. Once the installation is complete, you are set to install/run the VOP. 

If you used the online installation version, you may now exit Sun.com.  
You can also delete either executable file used for the JRE installation/update.

Note – The JRE installation/update does not remove old JRE versions. However, their 
continued presence is ignored. Use discretion about removing older JRE versions.

FIGURE 2-4 Platform Version Selection
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VOP Application Software 
The VOP application software installation/update process consists of four parts:

■ Download the latest VOP version (zip file)
■ Extract/unpack the zipped (compressed) contents
■ VOP installation and test launch

■ Windows OS
■ Linux/UNIX

■ Post-installation options

▼ Download VOP Zip 
Begin the VOP installation process by downloading the latest VOP version release level 
zip file from the designated download resource.

1. Create a local sub-folder for the VOP download.

We recommend creating the folder as a direct subordinate to the root (home folder in 
Linux/UNIX) and naming it “VOP_download”, or another name of your choice.

Note – This folder is temporary. You will delete it after the installation.

2. Download the latest version of the program from SunSolve.

3. Save the VOP zip file to the folder created in Step 1.

Once the VOP zip file is saved to your local disk, you can exit from SunSolve.

4. Install VOP on your processing platform, see:

“VOP Installation, Windows OS Computers” on page 33.

“VOP Installation, Linux/UNIX OS Computers” on page 50.
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VOP Installation, Windows OS Computers 
VOP software installation consists of the following parts:

■ Extract/unpack the zipped (compressed) file contents
■ Choose an installation method

■ Automatic (setup.exe)
■ Manual

■ Verify version levels
■ Test launch the LTO-4 VOP, if applicable (available in version 1.0.12)
■ Post-installation options

▼ How to Extract VOP Files, Windows OS
There are several methods of extracting the VOP folders/files from the zip file. The 
following example is modeled on the Windows XP operating system, and the WinZip 
utility that is typically part of the Windows suite. The following procedure uses the 
most direct method to extract the VOP files within the download folder.

Note – If you do not have WinZip, go to: 
http://www.winzip.com/ovwc17/winzip.htm. 

1. Open the sub-folder that you created in Step 1 of “Download VOP Zip” on page 32.

2. Click the right mouse button on the zip file. 

A menu appears, similar to FIGURE 2-5. 

FIGURE 2-5 WinZip Popup Menu

http://www.winzip.com/ovwc17/winzip.htm
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3. Choose WinZip > Extract to here (see FIGURE 2-6).

The WinZip utility extracts the VOP files into the current folder (see FIGURE 2-7).

Note – The zip file contents will vary, relative to the specific VOP version.

4. Open and read the LICENSE.txt file. 

5. Go to “Choose an Installation Method, Windows OS”.

FIGURE 2-6 WinZip Extract to Here

FIGURE 2-7 Extracted VOP Files, Windows Explorer
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Choose an Installation Method, Windows OS
On computers with Windows operating system, you have a choice between two setup 
procedures:

■ “How to Use the Automatic Setup”
■ “How to Use the Manual Setup” on page 38

▼ How to Use the Automatic Setup
The automatic setup process installs VOP program files within the Windows Program 
Files structure, and creates a Start Menu, Programs path for launching the program.

1. Double-click the setup.exe file.

The automatic VOP installation process begins.

Note – During the installation process there are several points where you are asked to 
provide a response, see FIGURE 2-10 on page 36. Unless you have a compelling reason to 
the contrary, accept all defaults presented.

FIGURE 2-8 Automatic VOP Installation

FIGURE 2-9 Automatic Installation Welcome
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Note – Once the installation process is complete, you should verify the Start Menu 
path, and test launch the newly installed VOP version.

2. Click Start, and select the Programs > VOP program folder.

Note – The newly installed VOP version (VOP_<Rel level>_Customer)  
should be listed in the Programs group listing (see FIGURE 2-11 on page 37).

FIGURE 2-10 Automatic Installation Progress Points
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Note – If this installation updates a previously auto-installed VOP version, the earlier 
version program folder is also listed.

3. Select the newest VOP version program folder, and click the executable file name.

The VOP application window (FIGURE 2-12) opens. 

Note – There is a noticeable delay when you open the VOP application for the first 
time of every PC power-on session while the anti-virus scan is in progress. Subsequent 
VOP launches, in the same PC power-on session, are quicker. During the delay, the only 
visible indication of the VOP program launching is with the hard drive activity 
indicator

Note – Connection In Progress appears in the two drive message windows, but the 
application is open without a drive connection actually being initiated. Notice that the 
Drive Name is NONE and all status indicators are black.

Note – The title bar for VOP version 1.0.12 shows Virtual Operator Panel only. The 
model number will not appear until you initiate a drive connection.

4. Go to “To Display the Program Help Menu” on page 41.

FIGURE 2-11 Start Menu VOP Path

FIGURE 2-12 VOP Application Window
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▼ How to Use the Manual Setup
The manual setup process installs VOP program files outside the Windows Program 
Files structure

Note – If this installation is to update an existing manually-installed earlier VOP 
version, the existing VOP folder must be renamed. If there is not an existing VOP 
folder, skip to step 2.

1. Rename an existing VOP folder as VOP_old.

See FIGURE 2-13.

2. Move or Copy the new VOP folder from VOP_download to the root folder.

FIGURE 2-14 shows the location and typical contents of the new VOP folder.

FIGURE 2-13 Rename VOP Folder

FIGURE 2-14 VOP Folder Location and Contents, Windows Explorer
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Note – Version 1.0.12 contains additional files for the ltoVOP application.

3. Delete the file names without file extensions.

Examples: multiVOP, ltoVOP, or sunVOP. These files (FIGURE 2-15) are non-Windows 
files, and they are not needed.

The new sunVOP.bat and ltoVOP.bat programs are now ready to launch, and you 
should perform a test launch to verify the setup. 

4. Double-click the sunVOP.bat batch file.

The sunVOP batch file window appears; then, the VOP window opens  
(see FIGURE 2-16 on page 40).

Note – There is a noticeable delay between the bath file window and the opening of 
the VOP application for the first time of every PC power-on session while the anti-virus 
scan is in progress. Subsequent VOP launches, in the same PC power-on session, are 
quicker. During the delay, the only visible indication of the VOP program launching is 
with the hard drive activity indicator.

FIGURE 2-15 VOP non-Windows Files
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Note – Connection In Progress appears in the two drive message windows, but the 
application is open without a drive connection actually being initiated. Notice that the 
Drive Name is NONE and all status indicators are black.

Note – The title bar for VOP version 1.0.12 shows Virtual Operator Panel only. The 
model number will not appear until you initiate a drive connection.

Until you establish a connection to the drive, you can use only the File and Help 
menus.

5. Go to “To Display the Program Help Menu” on page 41). 

FIGURE 2-16 VOP Batch File and Application Windows
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▼ To Display the Program Help Menu
Use the About command in the Help menu to verify the VOP version and Java version.

1. Click Help, then choose About.

The Drive About Dialog box (FIGURE 2-17) opens.

Note – The Drive Type field in VOP version 1.0.12 lists T10000A, T10000B, and T9840D.

2. Verify the release levels listed in the VOP Version and the Java Version fields.

If either of the release levels is not correct, replace it with the proper level.

Note – Java version 1.5, or higher, is required when you use VOP version 1.0.10 or 
higher. Earlier VOP releases were supported by Java 1.4.2_10, or higher.

3. Close the About dialog box.

4. Exit the program (use the File menu or click the “X” in the upper right corner).

FIGURE 2-17 VOP and Java Installation Verification, Solaris

FIGURE 2-18 Exit VOP, Windows
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▼ To Test Launch the ltoVOP Program
The ltoVOP.bat file is available in VOP 1.0.12.

1. Double-click the ltoVOP.bat batch file.

The LTO-4 Virtual Operator Panel window opens.

2. Exit from the ltoVOP program.

3. Go to “VOP Post-Installation Options, Windows” on page 43). 

FIGURE 2-19 Batch File - LTO

FIGURE 2-20 LTO-4 Virtual Operator Panel
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VOP Post-Installation Options, Windows
When you have confirmed the VOP program opens and the release level is correct; you 
can optionally create shortcuts, modify the opening batch file, and delete down-level 
versions or VOP folders/files that are not needed. You should delete or empty the VOP 
download folder that was created to temporarily hold VOP update downloads.

▼ To Create Optional Shortcuts, Windows
If you used automatic installation, you already have a Start Menu type of shortcut,  
and might well choose not to create additional shortcuts. However, if you used manual 
installation, you might consider creating a desktop shortcut.

Note – If this is an update to a previous manually installed VOP, any existing shortcut 
should work. Check the shortcut properties and edit them, as needed, to target the new 
sunVOP.bat file.

Use the following steps to quickly create a VOP shortcut on the desktop:

1. Click (single-click) the sunVOP.bat file.

2. Click the right mouse button and choose Create Shortcut (FIGURE 2-21).

FIGURE 2-21 Create Shortcut
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The new shortcut (Shortcut to sunVOP.bat) appears in the sub-folder file list.

3. Rename the shortcut.

Keep the name short, such as VOP.

4. Drag and drop the renamed shortcut to the desktop.

The desktop VOP shortcut icon (FIGURE 2-23) should work.

5. Double-click the new desktop VOP shortcut icon to test launch VOP.

See FIGURE 2-16 on page 40 to confirm VOP launch.

Note – You do not need to reconfirm VOP and Java version release levels.

6. Click File, then either choose Exit or click the “X”, in the application window upper 
right corner.

The VOP application window closes.

Note – Use normal Windows functions to create and locate additional shortcuts.

7. Repeat this process to create a shortcut for the ltoVOP.bat file, if desired.

FIGURE 2-22 VOP Batch File

FIGURE 2-23 Desktop VOP Shortcut Icon
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▼ To Display the Optional Heartbeat Indication, Windows
In VOP release 1.0.9, and lower, you can optionally enable a heartbeat indicator that 
appears on the VOP application window indicator stack, and blinks while the VOP has 
a running connection with the drive. 

Note – The heartbeat indicator is basically redundant because the VOP will detect an 
inadvertent lost connection with the drive, and display a “heartbeat failure” message in 
the VOP text message window. 

If you want the visual heartbeat indicator on the VOP application window, use the 
following instructions to edit the sunVOP.bat file:

1. Launch a simple text editor.

Notepad or Wordpad is OK.

Note – Avoid using a full word processing application.

2. Locate, and open sunVOP.bat. 

Note – The location of the batch file depends on the type of VOP installation used: 
Auto -     C:\Program Files\VOP_Rel_<release level>_Customer\sunVOP.bat 
Manual - C:\VOP<release level>\sunVOP.bat

The following, or similar lines of text should appear:

#   %1 is optional drive ip address to connect to java -classpath 
"lib;lib/VOP.jar;lib/borland.jar" -Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain %1

cd bin

3. Insert -b, followed by a space, just before the %1 in the last text line. 

For example: “VOPMain %1” edited to “VOPMain -b %1”.

Note – The -b parameter enables the heartbeat indicator. 
To disable an existing heartbeat indicator, delete the -b parameter.

4. Save and close the batch file.

When the VOP application window is open, the heartbeat indicator is present, as seen 
in FIGURE 2-24. While the VOP is connected to a drive, the indicator blinks.

FIGURE 2-24 Heartbeat Indicator
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▼ To Delete/Remove Folders/Files, Windows

Note – Although there is not any requirement to remove/delete no-longer-needed 
VOP folders, it is considered best practice to do so, once the newest version is fully 
functional. Even if the newest version becomes dysfunctional later, you can 
redownload, and reinstall the current version.

The following procedure removes/deletes no-longer-needed VOP program files: 

Note – Perform steps 1 & 3 following an automatic installation. 
Perform steps 2 & 3 following a manual installation.

1. Remove an auto-installed down-level VOP program folders/files:

a. Open the Control Panel, Add or Remove Programs utility.

All auto-installed VOP versions are listed (FIGURE 2-25).

b. Select the down-level VOP program.

Once you make the selection (VOP_Rel_1_0_8_Customer in FIGURE 2-25), the Add or 
Remove Program window changes, as shown in FIGURE 2-26 on page 47.

FIGURE 2-25 Add or Remove Programs, Windows



 

VOP Application Software

96179 • Revision JA  Chapter 2 Software Installation 47

c. Click Change/Remove to start the remove process.

You are asked to confirm the removal (FIGURE 2-27).

d. Click Yes to confirm, or No to cancel, and reselect.

Once the old VOP is removed, you see a confirmation notice (FIGURE 2-28).

e. Click OK, then close the Add or Remove Program window, and the Control Panel.

Note – The last post-installation step is to delete the no longer needed VOP download 
folder used to extract/unpacked folder.

f. Skip to step 3.

FIGURE 2-26 Remove Program Selection, Windows

FIGURE 2-27 Remove Program Confirmation, Windows

FIGURE 2-28 Remove Program Completion, Windows
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2. Delete the down-level VOP_old folders:

a. Open the root folder.

All VOP folders are listed (see FIGURE 2-29).

b. Right-click the down-level VOP_old folder, and choose Delete.

You are asked to confirm the folder deletion (FIGURE 2-30).

c. Click Yes to confirm, or No to cancel, and reselect.

Once the VOP_old folder is deleted, it no longer appears in the folder tree.

Note – The last post-installation step is to delete the no-longer-needed VOP_download 
folder used to extract/unzip the updated VOP folders/files.

d. Continue with step 3.

FIGURE 2-29 Delete VOP_old Folder, Windows

FIGURE 2-30 Delete VOP_old Folder Confirmation, Windows
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3. Delete the VOP_download folder:

a. Open the root folder.

The VOP_download folder you created to hold, and extract/unzip the VOP program 
folders and files is listed (see FIGURE 2-31).

b. Right-click the VOP_download folder, and choose Delete.

You are asked to confirm the deletion (FIGURE 2-32).

c. Click Yes to confirm, or No to cancel, and reselect.

Once the VOP_download folder is deleted, it no longer appears in the folder tree.

FIGURE 2-31 Delete VOP_download Folder, Windows

FIGURE 2-32 Delete VOP_download Folder Confirmation, Windows
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VOP Installation, Linux/UNIX OS Computers 
This section contains instructions to manually extract and install the VOP software on 
computers with Linux or UNIX operating systems. The installation consists of three 
parts: extract/unzip VOP files, install VOP, and post-installation options.

Note – There are multiple ways to accomplish the same task. The following procedures 
are modeled, using Solaris 10. You can use alternate means that you prefer, as long as 
the end results in a launchable VOP installation.

▼ To Extract VOP Folders/Files (Linux/UNIX)
Use the following procedure to extract the zipped VOP files:

1. Launch File Browser.

2. Navigate to the sub-folder that you created in Step 1 of “Download VOP Zip” on 
page 32.

3. Click and hold the right mouse button over the VOP zip file.

A list of commands appears.

4. Select Extract Here. 

The utility extracts the zipped contents behind the scene.

5. Click Reload in the tool bar.

The screen refreshes and displays the extracted files (FIGURE 2-33).

FIGURE 2-33 Extracted VOP Files, Solaris File Browser



 

VOP Application Software

96179 • Revision JA  Chapter 2 Software Installation 51

▼ To Set up the VOP, Linux/UNIX OS
The manual installation of the VOP program consists of the following parts: 

■ Install VOP
■ Verify the search path
■ Copy VOP folder to home
■ Delete Windows files

■ Confirm that the file is executable
■ Test launch a program

■ sunVOP
■ ltoVOP (version 1.0.12)

1. Make sure the Java JRE, and the VOP/bin folders locations are in the search path 
on the computer. 

If required, use Linux/UNIX utilities to specify their locations. This requires that you 
change the $PATH variable in the “.cshrc” file to include the java/bin directory. In the 
CLASSPATH file, add the path to the java directory.

Note – If this installation is to update an existing manually-installed earlier VOP 
version, the existing VOP folder must be renamed. If there is not an existing VOP 
folder, skip to step 3.

2. Rename an existing VOP folder as VOP_old.

3. Move or Copy the new VOP folder from VOP_download to the home folder.

4. Verify the new location and contents of the new VOP sub-folder.

Note – You should see a few sub-folders (such as: bin, icons, and lib) and some files. 

FIGURE 2-34 Extracted VOP Files, Solaris File Browser
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5. Delete the Windows only files.

The multiVOP, lotVOP.bat, and sunVOP.bat files (FIGURE 2-35) are not needed with the 
Linux/UNIX setup.

The sunVOP file (no extension) and the ltoVOP (version 1.0.12) are the Linux/UNIX 
executable files.

You should perform a test launch to verify the setup. 

6. Verify that the files are executable.

If the files are not executable, change the permission to be executable.

7. Double-click the sunVOP file.

FIGURE 2-35 Unneeded VOP Files, Solaris File Browser

FIGURE 2-36 Test Launch VOP, Solaris File Browser
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8. The Run or Display? dialog box (FIGURE 2-37) appears.

9. Click Run

The VOP application launches, and the VOP application window opens  
(see FIGURE 2-38).

Note – Connection In Progress appears in the two drive message windows, but the 
application is open without a drive connection actually being initiated. Notice that the 
Drive Name is NONE.

Note – The title bar for VOP version 1.0.12 shows Virtual Operator Panel only. The 
model number will not appear until you initiate a drive connection.

FIGURE 2-37 Solaris Run or Display? Dialog Box

FIGURE 2-38 VOP Application Window, Solaris
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10. Click Help, then choose About.

The Drive About Dialog box (FIGURE 2-39) opens.

Note – The Drive Type field in VOP version 1.0.12 lists T10000A, T10000B, and T9840D.

11. Verify the release levels listed in the VOP Version and the Java Version fields.

If the VOP release level is not correct, replace it with the proper level. If the Java 
version is not correct, contact your system administrator.

Note – Java version 1.5, or higher, is required when you use VOP version 1.0.10 or 
higher. Earlier VOP releases were supported by Java 1.4.2_10, or higher.

12. Close the Drive About Dialog box.

FIGURE 2-39 VOP and Java Installation Verification, Solaris
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13. Click File, then choose Exit, or click the “X”, in the application window upper right 
corner (see FIGURE 2-40).

The VOP application window closes.

14. Test launch the ltoVOP file.

The ltoVOP file is available in VOP 1.0.12.

a. Double-click the ltoVOP file.

b. The Run or Display? dialog box appears.

c. Click Run.

The VOP application launches, and the VOP application window opens  
(see FIGURE 2-38).

d. Close the application window.

FIGURE 2-40 Exit VOP, Solaris

FIGURE 2-41 ltoVOP Application Window, Solaris
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VOP Post-Installation, Linux/UNIX OS
When you are satisfied that the newly installed VOP program is functioning properly, 
you can optionally create shortcuts to the program file, delete down level VOP 
folders/files, and modify the sunVOP batch file.

▼ To Create Optional Shortcut Links

Note – If this is an update to a previous manually installed VOP, any existing shortcut 
should work. Check the shortcut properties and edit them, as needed, to target the new 
sunVOP file.

Use the following steps to quickly create a VOP shortcut link on the Solaris desktop:

1. Click (single-click) the sunVOP file.

2. Click the right mouse button and choose Make Link (FIGURE 2-42).

The new shortcut (link to sunVOP) appears in the sub-folder file list.

3. Rename the shortcut link.

Keep the name short, such as VOP.

4. Drag and drop the renamed shortcut link to the desktop.

The desktop VOP shortcut link icon (FIGURE 2-43) should now be functional.

FIGURE 2-42 Link to sunVOP

FIGURE 2-43 Solaris Desktop VOP Link Icon
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5. Double-click the new desktop VOP shortcut icon to test launch VOP.

The Run or Display? dialog box (FIGURE 2-44) appears.

6. Click Run.

The VOP application launches, and the VOP application window opens. See FIGURE 2-45 
to confirm that VOP launches.

Note – T10000 Virtual Operator Panel appears in the title bar of VOP versions prior to 
1.0.12. Version 1.0.12 displays Virtual Operator Panel only until you establish a valid 
drive connection.

7. Click File, then choose Exit, or click the “X”, in the application window upper right 
corner.

The VOP application window closes.

Note – Use normal Solaris functions to create and locate additional shortcuts.

8. Repeat the process to create a shortcut to the ltoVOP file, if desired.

FIGURE 2-44 Solaris Run or Display? Dialog Box

FIGURE 2-45 VOP Application Window, Solaris
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▼ To Create the Optional Heartbeat Indication, Linux/UNIX
In VOP release 1.0.9, and lower, you can optionally enable a heartbeat indicator which 
appears on the VOP application window indicator stack, and it blinks while the VOP 
has a running connection with the drive. 

Note – The heartbeat indicator is basically redundant because the VOP will detect an 
inadvertent lost connection with the drive, and display a “heartbeat failure” message in 
the VOP text message window. 

If you want the visual heartbeat indicator on the VOP application window, use the 
following instructions to edit the sunVOP file:

1. Launch the Vi text editor.

a. Locate, and open sunVOP. 

Note – The sunVOP file should be located in the version-specific folder created during 
the VOP installation: C:\VOP<release level>\sunVOP

The following, or similar lines of text should appear:

#!/bin/ksh

#cd $HOME/VOP<release level>

#   $1 is optional drive ip address to connect to

VOPdir=`echo $0 |sed 's!/VOP/.*!/VOP!'` 

vopdir2=`echo $VOPdir |grep "\.\/" |wc -c`

if [ $vopdir2 -ne "0" ]

then VOPdir="./" fi

chkVOPdir=`echo $VOPdir |wc -c`

if [ $chkVOPdir -lt "3" ]

then VOPdir=`which $0| sed 's!$0!!'` fi

cd $VOPdir

java -classpath "lib:lib/VOP.jar:lib/borland.jar" -Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain $1 &

b. Insert -b, followed by a space, just before the $1 in the last text line. 

For example: “VOPMain $1 &” edited to “VOPMain -b $1 &”.

Note – The -b parameter enables the heartbeat indicator. 
To disable an existing heartbeat indicator, delete the -b parameter.

c. Save and close the sunVOP file.

d. Enter the command: rehash.



 

VOP Application Software

96179 • Revision JA  Chapter 2 Software Installation 59

▼ To Delete/Remove Folders/Files, Linux/UNIX

Note – Although there is not any requirement to remove/delete no-longer-needed 
VOP folders, it is considered best practice to do so, once the newest version is fully 
functional. Even if the newest version becomes dysfunctional later, you can 
redownload, and reinstall the current version.

Use normal Linux/UNIX commands to delete no-longer-needed VOP program files:

1. Delete the down-level VOP_old directory/folder.

This folder was replaced by the update for VOP.

2. Delete the VOP_download directory/folder

This folder was temporary to hold and extract the updated VOP folders/files, and is no 
longer need.
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3

Starting VOP Programs

This chapter assumes operation of the Virtual Operator Panel (VOP) with a single tape 
drive interface. See Appendix B for additional guidelines when operating VOP within a 
multiple-drive private network.

For basic hardware requirements and connection description, see “Ethernet Connection 
to the Drive” on page 24.

The purpose of the VOP application has evolved from an operator panel for the 
T10000A tape drive (versions through 1.0.10), to provide a method to license and enroll 
the T9840D tape drive for encryption (version 1.0.11), and to provide an operator panel 
for other T-series tape drives (T10000B and T9840D) and enable enrollment of the LTO 
Generation 4 tape drive (1.0.12).

Overview
This chapter contains instructions for starting the VOP applications. Because the 
operating systems provide multiple means to start/launch applications, you can choose 
any one of the several listed here; and, a different one at any future VOP session:

■ “Windows” on page 62
■ “Linux/UNIX” on page 68
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Windows
There are two separate VOP applications:

■ T-series VOP

■ “The ltoVOP Application (Windows)” on page 66

T-series VOP (Windows)
You can start the VOP application in the following ways:

■ “Start Menu, Programs List (Windows)”
■ “Start Menu, Run Dialog Box (Windows)” on page 64
■ “Optional Desktop Shortcut (Windows)” on page 65
■ “Windows Explorer (Windows)” on page 65. 

The application displays in a separate window as shown in the following figure:

See Chapter 4, “VOP Operation - T-series” for detailed information on the sunVOP 
application.

FIGURE 3-1 VOP, Not Connected
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▼ Start Menu, Programs List (Windows) 
When the VOP was installed, the windows automatic setup utility created a pointer in 
the start menu program list that points to the VOP executable file.

1. Click Start and select the Programs > VOP program folder.

Note – All installed VOP versions (vop_<Rel level>_service) are listed in the Programs 
group (see FIGURE 3-2).

Note – If there are multiple VOP programs listed, make sure you have selected the 
intended folder before clicking the pointer. 

2. Click the pointer name.

The VOP window opens (FIGURE 3-1). You can resize and move the window around the 
desktop. See FIGURE 1-1 on page 25 for detailed descriptions of the window sections.

Note – There is a noticeable delay opening the VOP application window for the first 
time of every PC power-on session while your anti-virus scans.  
During the delay, the only visible indication is with the hard drive activity indicator. 
Subsequent VOP launches, in the same powered session, are quicker. 

Note – At this point, the application is open, but a drive connection has not been 
initiated.

FIGURE 3-2 Start Menu, Programs List VOP Path
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▼ Start Menu, Run Dialog Box (Windows) 
Use the following guidelines to launch VOP from the Run dialog box:

1. Click Start.

The Start menu (FIGURE 3-3) opens.

2. Select Run.

The Run dialog box (FIGURE 3-4) opens.

3. Do one of the following:
■ Enter the path to the desired VOP executable file.
■ Click the down arrow to select a previous entry.
■ Click the Browse command button to locate the desired VOP executable file.

Note – The path must point through the specific folder.

4. Click OK.

The VOP opens (FIGURE 3-1 on page 62). 

FIGURE 3-3 Start Menu,

FIGURE 3-4 Run Dialog Box
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▼ Optional Desktop Shortcut (Windows) 
If you created an optional desktop shortcut (FIGURE 3-5):

1. Double-click the shortcut icon.

The VOP opens (FIGURE 3-1 on page 62). 

See “Using VOP Menus and Controls” on page 74 for VOP operational guidelines, 
including Connect to Drive.

▼ Windows Explorer (Windows)
You can optionally start VOP from Windows Explorer (FIGURE 3-6):

1. Navigate to the VOP folder, then double-click the VOP executable file.

The VOP opens (FIGURE 3-1 on page 62). 

FIGURE 3-5 Desktop VOP Shortcut Icon

FIGURE 3-6 VOP Executable File
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The ltoVOP Application (Windows)
You can start the VOP application in the following ways:

■ “Start Menu, Run Dialog Box (Windows)”

■ “Desktop Shortcut Icon (Windows)”  on page 67

The application displays in a separate window as shown in the following figure:

See Chapter 5, “VOP Operation - LTO” for detailed information on the ltoVOP 
application.

FIGURE 3-7 LTO-4 Virtual Operator Panel
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▼ Start Menu, Run Dialog Box (Windows)
1. Click Start.

2. Select Run.

The Run dialog box (FIGURE 3-8) opens.

3. Do one of the following:
■ Enter the path to the desired VOP executable file.
■ Click the down arrow to select a previous entry.
■ Click the Browse command button to locate the desired VOP executable file.

Note – The path must point through the specific folder.

4. Click OK.

The ltoVOP window opens (FIGURE 3-7 on page 66). 

▼ Desktop Shortcut Icon (Windows)
Use this method if you have created a desktop shortcut.

1. Double-click the shortcut icon.

The ltoVOP window opens (FIGURE 3-7 on page 66). 

FIGURE 3-8 Run Dialog Box ltoVOP
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Linux/UNIX
There are two separate VOP applications:

■ T-series VOP
■ “The ltoVOP Application (Linux/UNIX)” on page 70

T-series VOP
You can start the VOP application in the following ways:

■ “Launch from a Terminal Window (Linux/UNIX)”
■ “Launch from the File Browser (Linux/UNIX)” on page 69
■ “Launch from a Shortcut (Linux/UNIX)” on page 69

See Chapter 4, “VOP Operation - T-series” for detailed information on the sunVOP 
application.

▼ Launch from a Terminal Window (Linux/UNIX)
1. Click Launch, then select Applications > Utilities > Terminal

A Terminal window opens.

Note – Make sure you are in the home directory/folder, or specify the complete path 
with the command.

FIGURE 3-9 VOP, Not Connected, Solaris
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2. Enter the command sunVOP. 

The VOP application launches, not connected (FIGURE 3-9). 

Note – At this point, only the application window is open. A drive connection has not 
been initiated.

See FIGURE 1-1 on page 25 for detailed descriptions of the application window sections.

Note – If you include the drive’s IP or alias, VOP will open and auto-connect to the 
designated drive.

▼ Launch from the File Browser (Linux/UNIX)
1. Start the File Browser.

2. Open the VOP folder.

3. Double-click the sunVOP file.

4. Click Run in the Run or Display? dialog box.

The VOP application launches and the VOP application window opens (see FIGURE 3-9).

▼ Launch from a Shortcut (Linux/UNIX)
1. Double-click the desktop VOP shortcut icon.

2. Click Run in the Run or Display? dialog box.

The VOP application launches and the VOP application window opens (see FIGURE 3-9).

FIGURE 3-10 VOP, Connected, Solaris
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The ltoVOP Application (Linux/UNIX)
You can start the ltoVOP application in the following ways:

■ “Launch from a Terminal Window (Linux/UNIX)”
■ “Launch from the File Browser (Linux/UNIX)” on page 71

See Chapter 5, “VOP Operation - LTO” for detailed information on the ltoVOP 
application.

▼ Launch from a Terminal Window (Linux/UNIX)
1. Click Launch, then select Applications > Utilities > Terminal

A Terminal window opens.

Note – Make sure you are in the home directory/folder, or specify the complete path 
with the command.

2. Enter the command ltoVOP. 

The ltoVOP application launches, not connected (see FIGURE 3-11). 

FIGURE 3-11 LTO-4 Virtual Operator Panel
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Note – If you include the drive’s IP or alias, VOP will open and auto-connect to the 
designated drive.

▼ Launch from the File Browser (Linux/UNIX)
1. Start the File Browser.

2. Open the VOP folder.

3. Double-click the ltoVOP file.

4. Click Run in the Run or Display? dialog box.

The VOP application launches and the VOP application window opens (see 
FIGURE 3-11).
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VOP Operation - T-series 

This chapter provides guidelines for Virtual Operator Panel (VOP) operation with a 
single drive interface to a T10000 or T9840D tape drive. See Appendix B for additional 
guidelines when operating VOP within a multiple-drive private network. The VOP 
does not provide any interconnection with the host data input/output interface. 

The VOP has three basic operational functions:

■ Drive status monitoring
■ Drive configuration settings
■ Drive operation utilities

Because the T10000 Tape Drive does not have a built-in, physical operator panel, the 
primary means of operational interface is by the drive Ethernet port (see FIGURE 4-1). 

Note – The only exception would be when the drive is mounted in a rack mount 
chassis, which has a physical operator panel for each drive. However, you can still use 
the VOP interface with a rack mount configured drive.

FIGURE 4-1 T10000 Tape Drive Rear Panel 

1. Ethernet Port 
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Note – When a Service Delivery Platform (SDP) site server unit is installed on site and 
monitoring installed drives via an Ethernet private network, the drive Ethernet port is 
100% dedicated to the service network. Therefore, the drive Ethernet port is NOT 
available for connection to the customer VOP. 

Using VOP Menus and Controls
This section provides guidelines for using the VOP menus, sub-menus, and other 
controls, such as dialog boxes and status indicators.

Note – The VOP application window illustrations in this section were captured on a 
Windows XP platform. The Linux/UNIX platform VOP application window has a 
slightly different look (see FIGURE 3-9 on page 68); but, the guidelines apply equally. 

The VOP application window provides several drop-down menus. When the drive is 
online, unavailable menus are dimmed (see the Configure menu label in FIGURE 4-2). 
Some menu commands have additional sub-menus or dialog boxes. 

Some status indicators are also an active link that allow you to toggle the state of the 
monitored drive item. Note that the mouse cursor does not change when you mouse-
over such an indicator.

During the course of selected operations, the VOP text message pane displays a 
transcript of the VOP actions, and will prompt you for additional input.

Note – The following sections provide more detailed guidelines.

FIGURE 4-2 VOP Window Menus and Indicator/Controls
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▼ Menu Bar Selections
In general, the following two steps are basic for all menus:

1. Click on an available menu label.

A drop-down list of available commands appears.

2. Select a command or sub-menu.

The drive message text windows, drive status indicators, and the VOP text message 
pane provide informational feedback.

File Menu 
Three commands are available in the File menu.

■ Clear Transcript
■ Connect to Drive,  on page 76
■ Exit,  on page 78

Note – File commands are available whether connected to a drive or not, and if 
connected, online and offline.

▼ To Use the Clear Transcript Command
Use the following guidelines to clear the VOP transcript:

1. Click File to open the menu.

2. Choose Clear Transcript (FIGURE 4-3) to clear text in the VOP transcript pane. 

The entire VOP transcript pane clears and the file menu closes.

FIGURE 4-3 Clear Transcript
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▼ To Use the Connect to Drive Command
Use the following guidelines to connect VOP to a designated drive:

Note – After a drive is connected, use this command to disconnect or to connect to a 
different drive. 

1. Click File to open the menu.

2. Choose Connect to Drive (FIGURE 4-4). 

The Connect to Drive dialog box (FIGURE 4-5) opens. 

FIGURE 4-4 Connect to Drive 

FIGURE 4-5 Connect to Drive Dialog Box, Windows
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3. Enter the drive’s IP address or alias, then click OK.

Factory preset (10.0.0.1), a preassigned static IP, or a preassigned alias.

After the VOP establishes connection with the designated drive, the VOP window 
changes to the connected stage (see FIGURE 4-6). In the connected stage, additional 
menus are available, the status indicators are a color other than black, and the text 
pane/transcript indicates the VOP is logged into the drive.

Note – VOP versions higher than 1.0.10 indicate the drive model at the beginning of 
the title bar (T10000A, T10000B, or T9840D).

Note – When operating VOP with a single drive, disconnect the crossover cable, and 
reconnect it to a different drive. If the newly connected drive has the same IP (factory 
preset 10.0.0.1), the VOP will auto-reconnect to the new drive.  
Otherwise, perform Step 3 on page 77 to designate a different drive IP.  
 
When operating in a private network, leave the PC Ethernet cable connected to the 
Ethernet switch, and perform Step 3 on page 77 to designate a different drive IP. 

FIGURE 4-6 VOP, Connected, Windows
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▼ To Use the Exit Command
Use the following guidelines to exit the VOP session:

1. Click File to open the menu.

2. Choose Exit (FIGURE 4-7). The VOP application window closes.

Note – If the VOP was connected to a drive, the Ethernet connection terminates.

Drive Operations Menu 
FIGURE 4-8 shows the online commands of the Drive Operations menu.

Note – Notice that the Format Tape label is dimmed, which indicates that it is not 
available online. Format Tape commands are only available when the drive is offline. 

FIGURE 4-7 Exit

FIGURE 4-8 Drive Operations Menu 
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Load Tape Command 
This command causes a cartridge that is present in the loading slot to load. 

Note – The only time a cartridge would be present in the loading slot, but not loaded 
occurs when it had been previously loaded, then unloaded, but not physically removed.

Unload Tape Command 
This command causes a loaded cartridge to rewind and unload.

Note – An unloaded cartridge must be physically removed from the drive by library 
robotics or manually from the rack mount configuration. Otherwise, it remains in the 
loading slot, but NOT loaded into the drive.

Set Offline/Online Command 
■ When the tape drive is online, this command reads Set Offline.  

Click Set Offline to set the drive offline.

■ When the tape drive is offline, this command reads Set Online.  
Click Set Online to set the drive online. 

You can click the Online status indicator (see FIGURE 4-9). 

Note – When the drive goes offline, the status indicator turns gray and the label 
changes to Offline; and, the Configure menu label turns blue.

FIGURE 4-9 Set Drive Offline



 

Drive Operations Menu

80 VOP Customer User’s Guide • June 2008   Revision JA • 96179

IPL Drive Command
This command causes the tape drive to perform an initial program load (IPL).

Note – VOP looses communications with the drive during the IPL. Once the drive IPL 
is successfully completed, VOP automatically reconnects with the drive. 

Force Dump Command
This function forces a diagnostic dump of current contents of various drive registers. 
This dump is stored in the tape drive’s internal memory and the dump status indicator 
changes to orange. 

Note – The forced dump operation also causes a drive IPL; and, once the drive 
successfully completes the IPL, fffc appears in the drive message window.

Format Tape Command
This command is only available when the drive is offline.  
(see “Format Tape Cartridge Dialog Box (Offline)” on page 81 for details.)

Note – The following drive operation commands only appear on the menu for 
encryption-capable drives that are also encryption-enabled. Refer to the encryption 
documentation for more information.

Reset Drive Command
This command erases all current media keys from the drive volatile memory.  
The drive is inoperable until media keys are loaded into the drive memory.

Note – When the Reset Drive command is selected, the encryption status indicator 
changes to orange, and the label identifies missing keys. 

Zero Drive Command

Caution – DRIVE DAMAGE. Once the drive is zeroed, it is totally disabled and  
must be returned to the factory. DO NOT SELECT ZERO DRIVE WITHOUT 
CONSULTATION WITH SUN STORAGETEK SUPPORT.

This command deletes all encryption keys including the internal enabling key. 
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Note – Should you select this command, a confirmation dialog box appears, which will 
allow you to confirm or cancel. 

Format Tape Cartridge Dialog Box (Offline)
The offline format tape cartridge dialog box (FIGURE 4-10) provides four utilities.

Three command buttons are on the bottom of the format tape dialog box:
■ Make - Initiates the selected utility.
■ Abort - Terminates an in-progress utility.
■ Done - Closes the dialog box.

▼ To Format a Tape Cartridge (Offline)
Use the following general guidelines to perform any of the utilities: 

1. Make sure the drive is offline.

If not offline, select Drive Operations > Set Offline, or click the Online status indicator  
(see FIGURE 4-8 and “Set Offline/Online Command” on page 79).

2. Select the appropriate utility radio button. 

Note – See the individual utility paragraphs for additional information and/or detail: 
“Make Data Tape” on page 83 
“Make Code Tape” on page 83 
“Make Dump Tape” on page 84 
“Rebuild MIR” on page 84

3. Click MAKE to start the selected utility. 

A prompt to insert a cartridge appears.

FIGURE 4-10 Format Tape Submenu 
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Note – If there is a cartridge in the drive, it unloads. You must physically remove the 
unloaded cartridge.

4. Insert a write-enabled cartridge.

When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 4-11) is in the write-enabled (unlocked) position.

The drive performs the selected utility, displays relative information in the VOP 
transcript pane, then unloads the cartridge.

Note – You can cancel a selected utility by clicking ABORT before inserting the 
cartridge. Once the cartridge has been inserted, the utility runs to completion.

5. Remove the unloaded cartridge.

You now have the following options:

■ Repeat the current selected format tape command (go to Step 3 on page 81).

■ Select a different format tape command (go to Step 2 on page 81).

■ Exit the format tape submenu (continue with Step 6).

6. Click DONE to exit the format tape submenu.

The Format Tape Cartridge dialog box closes.

FIGURE 4-11 Tape Cartridge Write-Protect Switch 

1. Write-protect switch
2.  Unlocked position
3.  Locked position

T103 4091

2

3
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Make Data Tape 
The Make Data Tape utility reformats a tape cartridge for reuse as a data tape cartridge. 
Existing headers are removed and the Media Information Region (MIR) is rewritten to 
identify the cartridge as empty and therefore ready for write operations.

Note – The Make Data Tape utility does not erase existing data. Old data can still be 
recovered by special data recovery applications. Therefore, if data security is a concern, 
you must configure the drive for full Data Security Erase (DSE) - Yes, and initiate an 
erase command from the host software before you select the Make Data Tape utility.

Use the general guidelines, beginning on page 81, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 4-11) is in the write-enabled (unlocked) position.

Make Code Tape 
The Make Code Tape utility reformats a tape cartridge with a special format, and 
downloads the drive firmware code from the drive memory to the tape cartridge. The 
MIR is then written to identify the cartridge as a “code” tape. You can use the code tape 
to upload drive firmware to other tape drives.  
Use the general guidelines, beginning  on page 81, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 4-11 on page 82) is in the write-enabled (unlocked) position

Note – The VOP heartbeat feature is not compatible with the Make Code Tape utility in 
VOP version 1.0.9, and lower. If the heartbeat feature is active when the Make Code 
Tape utility is initiated, the VOP loses connection to the drive shortly after the drive 
begins the utility. 
 
However, after the utility starts, the drive continues until completion.  
The VOP quickly reconnects to the drive, but does not regain monitoring the utility’s 
progress, nor does it display a successful code tape completion message. However, the 
VOP detects and displays the cartridge unloading at the end of the utility.  
 
To prevent losing the VOP-to-drive connection during the Make Code Tape utility with 
VOP version 1.0.9 and lower, you must make sure the heartbeat feature is not enabled. 
To disable the heartbeat feature, remove the “-b” parameter from the “sunVOP.bat” file. 
See “To Display the Optional Heartbeat Indication, Windows” on page 45 for guidelines 
to modify the batch file. The batch file revision must be done prior to starting the VOP 
session in which you intend to use the Make Code Tape utility.
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Make Dump Tape 
The Make Dump Tape utility reformats a tape cartridge with a special format. The MIR 
is written to identify the cartridge as a “dump” tape. You can use a formatted dump 
tape to download diagnostic “dump” data from drive memory. Service representatives 
use formatted dump tapes with the diagnostic routines that are available offline. 

Use the general guidelines, beginning on page 81, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 4-11 on page 82) is in the write-enabled (unlocked) position.

Rebuild MIR 
You can use the Rebuild MIR utility to repair a data tape cartridge that has an invalid 
or corrupted MIR. The utility reads the file headers all the way to the End of Data 
mark. Then, the MIR is rewritten to correctly reflect the tape contents. This utility could 
take well over one hour to rebuild the MIR on a full or nearly full data tape cartridge. 

Use the general guidelines, beginning  on page 81, to perform this utility.  
When the screen display prompts you to insert a cartridge, make sure the write-protect 
switch (FIGURE 4-11 on page 82) is in the write-enabled (unlocked) position.

Note – See “Media Information Region” in the T10000 Tape Drive Operator’s Guide, 
PN 96174 for additional MIR information.
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Retrieve Menu 
FIGURE 4-12 shows the Retrieve menu commands available online and offline.

See the following sections for more detail and guidelines:

■ “View Drive Data Command” on page 86
■ “View Date & Time Command” on page 96
■ “Dumps to File” on page 97
■ “Perms to File” on page 98
■ “Logs to File” on page 99

Note – In VOP version 1.0.9 and lower, there is also a Get and Display command in the 
Retrieve menu. However, it is not a functional command with the customer version of 
VOP. Should you select the command, you will only see an error message. 
 
If you are operating VOP 1.0.9 or lower, consider an upgrade to the newest version.

FIGURE 4-12 Retrieve Menu 



 

Retrieve Menu

86 VOP Customer User’s Guide • June 2008   Revision JA • 96179

View Drive Data Command 
The View Drive Data command (see FIGURE 4-12 on page 85) displays current drive 
configuration settings and other drive data on selectable property sheets (tabs). 

Encryption-capable drives open to the Encrypt tab (FIGURE 4-14) while other drives open 
to the Fibre tab (FIGURE 4-15). The Keyid and Missing tabs provide information that 
relates to encryption-capable drives.

Note – The View Current Drive Settings property sheets are view (display) only. See 
“Configure Menu” on page 100 for detailed descriptions and guidelines for changing 
configuration settings. 

FIGURE 4-13 View Current Drive Settings Property Sheets
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Encrypt Property Sheet
The Encrypt tab (FIGURE 4-14) displays encryption-related data. 

FIGURE 4-14 View Current Drive Settings, Encrypt Tab
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Fibre Property Sheet
The data displayed on the Fibre tab is specific to the type of drive interface.  
The Fibre Channel Protocol (FCP), shown in FIGURE 4-15, has FCP specific data. The 
Fibre Interface Connection (FICON), shown in FIGURE 4-16 on page 89 has FICON specific 
data. There is a similar list of parameters for a T9840D drive.

 

FIGURE 4-15 View Current Drive Settings, Fibre Tab (FCP Interface) 
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The Fibre tab for the FICON interface (FIGURE 4-16) is very similar to the FCP interface 
(FIGURE 4-15 on page 88), with the exception of the FICON specific emulation setting.

 

FIGURE 4-16 View Current Drive Settings, Fibre Tab (FICON Interface) 



 

Retrieve Menu

90 VOP Customer User’s Guide • June 2008   Revision JA • 96179

Keyid Property Sheet
The Keyid tab (FIGURE 4-17) displays a list of key identifiers.

FIGURE 4-17 View Current Drive Settings, Keyid 
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Manufacturing Property Sheet
The Manufacturing tab (FIGURE 4-18) displays factory preset settings, such as drive serial 
number, and default world wide names.

Note – The serial number of a T10000A drive begins with 531 while the serial number 
of a T10000B drive begins with 572. 
The drive model number of a T10000A drive displays as T10000 (see the figure above) 
while the model number of a T10000B drive displays as T10000B.

FIGURE 4-18 View Current Drive Settings, Manufacturing Tab 
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Missing Property Sheet
The Missing tab (FIGURE 4-19) displays a list of missing key identifiers.

FIGURE 4-19 View Current Drive Settings, Missing 
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Network Property Sheet
The Network tab (FIGURE 4-20) displays the Network node name. The factory preset 
default is comprised of the drive model number (t10000) and the last nine digits of the 
drive serial number. 

This tab also displays the current static IP settings. FIGURE 4-20 shows factory preset 
static IP parameters, which can be changed through the Configure menu  
(see “Network Property Sheet” on page 117).

FIGURE 4-20 View Current Drive Settings, Network Tab 
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Rfid Property Sheet
The Rfid tab (FIGURE 4-21) displays data stored in the radio-frequency identification 
(Rfid) memory chip in the T10000 tape cartridge. The Rfid chip stores data related to 
cartridge contents and statistics. The data is similar to data stored in the media 
information region (MIR) on the tape, and is updated with each cartridge 
mount/dismount. An Rfid module in the drive reads the Rfid chip while the cartridge 
is loaded, and is viewable (read-only) by the VOP application.

FIGURE 4-21 View Current Drive Settings, Rfid Tab 
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Version Property Sheet
The Version tab (FIGURE 4-22) displays the current drive firmware level.

 

FIGURE 4-22 View Current Drive Settings, Version Tab 
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View Date & Time Command
This command displays the date and time of the drive internal clock module. When 
you select View Date & Time (FIGURE 4-23), the drive date and time appears in the VOP 
transcript pane, as shown in FIGURE 4-24. 

Notice in FIGURE 4-24 that the drive clock setting is lagging behind the VOP time at the 
left end of the same text line. The drive clock only operates while the drive is powered; 
therefore, the drive clock time can fall behind real clock time during times that the 
drive is not powered. Most library configurations set the drive clock in-sync with the 
library clock. However, you can manually set the drive clock when the drive is offline.

Note – See “Set Clock Command” on page 121 to reset the drive clock.

FIGURE 4-23 View Date & Time 

FIGURE 4-24 Date & Time Display 
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Dumps to File Command
The Dumps to File command (FIGURE 4-25) allows you to retrieve and save diagnostic 
dumps that are currently stored in the drive memory. 

▼ Dumps to File
1. Choose Dumps to File to open an operating system save dialog box

The save dialog box allows you to name the file, and where to save the file.

2. Name the file, specify the target folder, and click Save.

The operating system saves the dump file in the specified location.

The VOP transcript (FIGURE 4-26) documents the action, including the path to the file.

Note – Notice that the drive status dump indicator dimmed after the dump file was 
retrieved. However, the dump is still present in drive memory until intentionally 
deleted by a service representative, or until the drive firmware is updated.

FIGURE 4-25 Dumps to File

FIGURE 4-26 Dumps to File Transcript
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Perms to File Command
The Perms to File command (FIGURE 4-27) allows you to retrieve and save all the 
permanent errors that are currently stored in the drive memory. 

▼ Perms to File
1. Choose Perms to File to open an operating system save dialog box.

The save dialog box allows you to name the file, and where to save the file.

2. Name the file, specify the target folder, and click Save.

The operating system saves the perm file in the specified folder.

The VOP transcript (FIGURE 4-28) documents the action, including the path to the file.

FIGURE 4-27 Perms to File

FIGURE 4-28 Perms to File Transcript
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Logs to File Command
The Logs to File command (FIGURE 4-29) allows you to retrieve and save event logs that 
are currently stored in the drive memory. 

▼ Logs to File
1. Choose Logs to File to open an operating system save dialog box.

The save dialog box allows you to name the file and where to save the file.

2. Name the file, specify the target folder, and click Save.

The operating system saves the log file in the specified folder.

The VOP transcript (FIGURE 4-30) documents the action, including the path to the file.

FIGURE 4-29 Logs to File

FIGURE 4-30 Logs to File Transcript
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Configure Menu
The Configure menu commands (FIGURE 4-31) and submenus are available when the 
drive is offline.Use them to:

■ Change drive configuration settings

■ Save the drive configuration values in a file

■ Set the date and time in the drive (clock)

■ Load drive microcode from a tape

Note – The drive must be offline, and should not be available to the host when 
exercising the Configure menu commands. Some changes require the drive to perform 
an Initial Program Load (IPL) to affect configuration changes. 

Drive Data Command
The Drive Data command (FIGURE 4-32) allows you to change configuration settings.

FIGURE 4-31 Configure Menu

FIGURE 4-32 Configure > Drive Data
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The multi-tab Configure Drive Parameters property sheet opens. 

Notice that there are several selection methods on the property sheets:

■ Drop-down list boxes 

■ Radio buttons

■ Text fields

Before discussing the available configuration settings, you should be familiar with the 
three command buttons across the bottom of every tab.

When you select a property sheet (tab), the current drive parameter values appear. If 
you change a setting, the adjacent Update checkbox indicates a pending change. 
Clearing the checkbox cancels the pending change for only that parameter.

Configure Command Buttons 
The three command buttons across the bottom of the Configure Drive Parameters 
dialog box (see FIGURE 4-34) directly affect drive configuration settings. 

Load Drive Config 
Clicking Load Drive Config allows you to retrieve a previously saved file of 
preselected drive configuration parameters/settings.  
See “To Save Drive Config” on page 120 for guidelines on saving a drive 
configuration.

Note – You will need to use normal file browsing to locate the saved file.

Once the retrieved file is opened, it populates all tabs with the saved configuration 
parameter values/settings.

FIGURE 4-33 Property Sheets

FIGURE 4-34 Configure Command Buttons
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Note – Marked Update checkboxes identify changed parameter values/settings.  
The imported saved configuration file includes drive specific parameters of the 
originating drive. Make sure you clear or reset drive specific parameters to accurately 
reflect the drive importing the saved configuration file.

You have the choice to retrieve a different file, clear check boxes of individual 
marked parameters, edit any specific parameter; or cancel or commit all pending 
(check-marked) configuration changes.

Commit 
Clicking Commit initiates a drive IPL to activate pending changes.

Note – VOP loses connection to the drive when IPL begins. However, VOP 
automatically reconnects to the drive after a successful IPL.

After the drive completes IPL, and VOP has reconnected to the drive, you should 
review Retrieve > Drive Data tabs to verify the new parameter values/settings  
(see “View Drive Data Command” on page 86). If required, place the drive offline, 
and repeat the configuration process see “Drive Data Command” on page 100). 

Cancel 
Clicking Cancel clears any/all pending change selections for all four tabs.
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Encrypt Property Sheet
The Encrypt tab (FIGURE 4-35) contains information about the encryption characteristics 
of the drive (use of tokens and permanently encrypting) and enrollment information. 
See the encryption documentation for guidelines on how to use this property sheet.

FIGURE 4-35 Configure Drive Parameters, Encrypt Tab



 

Configure Menu

104 VOP Customer User’s Guide • June 2008   Revision JA • 96179

FCP Fibre Property Sheet
The FCP Fibre tab (FIGURE 4-36) contains drive FCP configuration settings that you can 
change for the T10000A tape drive. The parameters are similar for the T10000B or 
T9840D tape drive. 

Notice that there are three different selection methods on the Fibre tab:

■ Drop-down list boxes - Emulation, language, Pa/b max recv size,  
and Pa/b speed negotiation.

■ Radio buttons - Data compression, Data security erase, Standard Label protect,  
Tape completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

■ Text fields - Library address, and World Wide Name (drive, ports A & B).

Note – See FIGURE 4-37 on page 105 for the FICON Fibre tab.

FIGURE 4-36 Configure Drive Parameters, Fibre Tab (FCP)
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FICON Fibre Property Sheet
The FICON Fibre tab FIGURE 4-37) contains drive FICON configuration settings that you 
can change, 

Notice that there are three different selection methods on the Fibre tab:

■ Drop-down list boxes - Emulation, Language, Pa/b max recv size,  
and Pa/b speed negotiation.

■ Radio buttons - Data compression, Data security erase, Standard Label protect,  
Tape completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

■ Text fields - Library address, and World Wide Name (drive, ports A & B).

Note – See FIGURE 4-36 on page 104 for the FCP Fibre tab.

 

FIGURE 4-37 Configure Drive Parameters, Fibre Tab (FICON)
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The following guidelines provide additional detail for changing drive settings.

Note – The current drive parameter settings were selected by the installation team to 
match pre-determined site requirements. Changing the drive parameter setting could 
materially affect drive performance. Therefore, you should change drive parameter 
settings only as instructed by your IT manager, or Sun StorageTek Support.

▼ To Set an Emulation
1. Click the down arrow to see an item list of emulation options. 

The available emulation option list appears with the current option highlighted.

2. Select an alternative option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – The available emulation options are specific to the active interface and the tape 
drive model. FIGURE 4-38 shows the T10000A FCP options. FIGURE 4-39 show the 
T10000A FICON options. T9840D emulation options are different.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-38 T10000A Emulation Options - FCP

FIGURE 4-39 T10000A Emulation Options - FICON
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▼ To Set Data Compression
See FIGURE 4-40 for available data compression options.

1. Click the appropriate radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – Data compression radio buttons are mutually exclusive. The option defaults to 
the last saved selection. Yes is preset at the factory. See TABLE 4-1 for descriptions.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-40 Data Compression Options

TABLE 4-1 Data Compression Option Descriptions

Option Use/Meaning

No Data is not compressed, by default, but can be overridden by the host for a job.

Yes Data is compressed, by default, but can be overridden by the host for a job. 

Off Data compression is disabled by default, and cannot be overridden by the host. 
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▼ To Set Data Security Erase
See FIGURE 4-41 for available data security erase (DSE) options.

1. Click the appropriate radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – The DSE radio buttons are mutually exclusive. The option defaults to the last 
saved selection. See TABLE 4-2 for descriptions.

Note – In June 2008, the factory setting for the T9840D will be Yes. Drives 
manufactured before this date were set to No.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Set Standard Label Protect
See FIGURE 4-42 for available standard label protect (SL Prot) options.

1. Click the appropriate radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

FIGURE 4-41 DSE Options

TABLE 4-2 DSE Option Descriptions

Option Use/Meaning

Yes Enables a full DSE. A random binary pattern is written on the media, over-writing existing 
data, from the point of an “Erase” command to the End of Tape mark. 

No Writes an end of data mark on the media that indicates valid data does not exist beyond 
the point of an “Erase” command. Data is actually still present beyond the end of data 
mark, and it can be retrieved by special tape utilities.

FIGURE 4-42 Standard Label Protect Options
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Note – The SL Prot radio buttons are mutually exclusive. The option defaults to the 
last saved selection. No is preset at the factory. See TABLE 4-3 for descriptions.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Set Library Address
FIGURE 4-42 shows the Library address text field.

Note – The library address is a two-character hexidecimal notation, preset at the 
factory to ff. It should remain at ff for all libraries except the 9310 PowderHorn, where 
it is manually keyed to the drive cabinet position, as viewed from the cabinet rear. 

1. Select the current entry.

The setting value is highlighted.

2. Type in the appropriate two-character hexidecimal Library address.

The changed value appears and a check mark appears in the Update checkbox.

Note – Valid entry for L-Series libraries and the SL8500 is the factory default ff. 
Valid entries for the 9310 PowderHorn Library 9741/9741E drive cabinet is  
00 through 09 (top, down), left column; and 0A through 13 (top, down) right column.

TABLE 4-3 Standard Label Protect Options

Option Use/Meaning

No Disables standard label protection. 

Yes Enables standard label protection. 

Notes:
Consider the following: 
1. Select Yes if label overwrite code is loaded, or if running standard labels and wish the drive to display a fatal 

error (CHK 33EX) when writing a non-80-byte record for VOLSER or HDR1.
2. Select No if you are using NL or NSL tape processing.
3. POST WRCART cannot be run with Yes selected

FIGURE 4-43 Library Address
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3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Enable Tape Completion Display
See FIGURE 4-44 for available Tape completion display options.

1. Click the appropriate option radio button.

The selected button is highlighted, and a check mark appears in the Update checkbox.

Note – The radio buttons are mutually exclusive. The option defaults to the last saved 
selection. No is preset at the factory. 

When No is selected, the tape completion display is disabled.

When Yes is selected, the tape completion display appears in the secondary drive 
message window when there is a cartridge loaded in the drive. 

The display (FIGURE 4-45) provides an indication of tape completion (percentage of tape 
media with written data).

Note – The view-only tape completion display is superseded by higher priority messages 
that require use of the secondary window.

FIGURE 4-44 Tape Completion Display Options

FIGURE 4-45 Tape Completion Display
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2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Set the Language 
This option sets the language in which certain operational drive messages, such as 
loading, unloading, etc. (see TABLE 4-4) are displayed in the drive message windows. 

1. Click the down arrow to see an item list of available languages. 

The available language list appears with the current selection highlighted.

2. Select another option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – English is preset at the factory.

FIGURE 4-46 Drive Message Language Options

TABLE 4-4 Translated Drive Messages 

English Espanol Francias Italiano Deutsch

*Cleaning* *Limpia* Nettoyage *Pulir* Reinigen

*Erasing* *Borrando* Effacement *Cancella* *Loeschng*

Loading Cargando Chargement Carico Laden

Locating Situando Recherche Ricerca Suchen

NT Ready F Noprep P Npret PTG No PRT P N Bereit N

NT Ready U Noprep N Npret U No PRT N N Bereit G

Ready A

Ready F Prepda P Pret F Pronto P Bereit G

Ready U Prepda N Pret U Pronto N Bereit N

Rewinding Rebobinar Rebobinage Riavvolg Spult-R

Unloading Descarga Dechargemt Scaricam Entladung
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3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Set the World Wide Name 
The World Wide Name (WWN) identifies the drive node. This string of 16 hexidecimal 
characters (FIGURE 4-47) represents a 64-bit unique identifier that distinguishes the 
individual drive from all other devices, worldwide. Characters 2 through 6 identify the 
specific manufacturer. Sun StorageTek branded devices have the company ID “00104F”. 
Other characters reveal additional information, including an identifier unique only to 
the specific device. 

Sun Microsystems assigns a block of three WWNs (from a pool of company-specific 
WWNs) to each tape drive during the manufacturing process. One for the drive and 
one each for the two fiber-optics interface ports. The drive node is assigned the first 
WWN of the block, and the next two WWNs, in sequence, are assigned to the ports. 
Notice the last two characters in FIGURE 4-47 is “9d”. If you refer back to the entire fibre 
tab (FIGURE 4-36 on page 104, FCP or FIGURE 4-37 on page 105, FICON) the port A WWN 
ends with “9e”, and the port B WWN ends with “9f”.

The ‘(default)’ indicates that this WWN was preset at the factory. Certain libraries 
override the default WWN with a library-assigned dynamic WWN (dWWN). Typically, 
only the last four characters differ from the default WWN. When dWWNs are active, 
‘(library)’ appears in the label. Also, the WWN can be manually overridden with a 
custom WWN. In some circumstances, a service representative might customize a 
replacement drive’s WWN to be the same as the replaced, defective drive’s WWN. This 
precludes a requirement for a full system reset to acknowledge a new WWN.

Note – Indiscriminately changing the WWN could result in the drive being unavailable 
to the host. 

1. Overwrite the appropriate hexidecimal characters with the specified new characters.

The changed value appears, and a check mark appears in the Update checkbox.

Note – When a customized WWN is active, ‘(custom)’ appears in the label.

Note – If a custom WWN is applied to the drive node, custom WWNs must also be applied 
to the interface ports.

FIGURE 4-47 World Wide Name Text Field
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2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change. 
 
The original, factory-preset default WWN can be retrieved from the Retrieve > View 
Drive Data > Manufacturing tab (FIGURE 4-18 on page 91).

Attributes of Interface Ports
There are two identical interface ports attribute groups (FIGURE 4-48):

Note – Pa = Port A, Pb = Port B

▼ To Set Port Physical Address Attributes
Hard-assigned Physical Address (No/Yes)

When Yes is selected, the drive uses a specified hard physical address (PA).  
When No (factory-preset default) is selected, the drive seeks a soft PA.

Arbitrated Loop Address (loop ID)

This entry (0 - 125) specifies the loop ID when the Hard PA selection is Yes.  
Factory-preset defaults are: 0 for Port A, 1 for Port B.

Soft-assigned Physical Address (Hi/Lo)

FIGURE 4-48 Interface Port Attributes
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Soft PA is effective only when the Hard PA selection is No.  
When Soft PA is Hi, the drive seeks an available loop ID in a descending order. 
When Soft PA is Lo (factory-preset default), the drive seeks an available loop ID in a 
descending order.

Note – Port physical address attributes are only used when the drive is in an 
arbitrated-loop. The settings are not applicable when the drive is in an interface fabric.

1. Reset the port physical address attributes as directed by your IT manager.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Set the Maximum Receive Size
The maximum receive (max recv) size determines the maximum data frame size for 
data processing (see FIGURE 4-49).

Caution – POTENTIAL DRIVE DAMAGE. Older versions of VOP display several 
size options. The smaller size options are not valid with the T10000 drive. Furthermore, 
an attempt to switch to any setting other than 2112 or 2048, could cause the drive to fail 
to complete the IPL DO NOT SELECT ANY SIZE OPTION OTHER THAN 2112 or 
2048.

1. Click on the down arrow to see an item list of available data frame sizes. 

The available frame size list appears with the current selection highlighted.

Note – 2112 is the factory preset default. Do not change unless directed by your IT 
manager or Sun StorageTek Support.

Note – You might see radio buttons instead of the list of frame sizes.

2. Select the alternative option to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

FIGURE 4-49 Max Data Frame Size Options
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Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

▼ To Enable the Port World Wide Name Override
Each port has a unique WWN (see FIGURE 4-50) that can be overridden.

Note – See “To Set the World Wide Name” on page 112 for additional 
information/detail.

1. Overwrite the appropriate hexidecimal characters with the specified new characters.

The changed value is displayed, and a check mark appears in the Update checkbox.

Note – If a custom WWN is applied to the drive node, custom WWNs must also be 
applied to the interface ports.

Note – When a customized WWN is active, ‘(custom)’ appears in the label.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-50 Port World Wide Name Text Fields
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▼ To Set Speed Negotiation
When Auto (see FIGURE 4-51) is selected, the drive operates at the interface negotiated 
speed, which is typically determined by the slowest attached device. When a fixed 
rate is selected, the drive will operate only at the specified speed.

1. Click on the down arrow to see an item list of available port speeds. 

The available port speed list appears with the current selection highlighted

2. Select another option in the item list to change the setting.

The selected option is highlighted, and a check mark appears in the Update checkbox.

Note – Auto is preset at the factory. Do not change unless directed by your IT manager 
or Sun StorageTek Support. 
 
A fixed rate might cause the drive to be unavailable, unless all other interface devices 
are set to the same speed.

3. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-51 Port Speed Negotiation Options
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Network Property Sheet
The Network tab (FIGURE 4-52) provides network related options. When you select the 
Network tab, the current settings are displayed. The information in the following figure 
is from a T10000 tape drive.

If you are connected to a T9840D tape drive, the display contains five fields:

■ IP address

■ Subnet mask

■ Gateway

■ MIM host IP address

■ MIM file path

Note – The entries shown in FIGURE 4-52 are preset at the factory, and should only be 
changed by the direction of your IT manager.

FIGURE 4-52 Configure Drive Parameters, Network Tab
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▼ To Set a Static IP Address 
Three parameters (FIGURE 4-53) determine the static IP addressing for the drive. 

Each parameter has four 3-digit groups, factory preset to the following values:

Note – If your site is monitored by a Service Delivery Platform (SDP), all monitored 
drives are set to a dynamic IP address, controlled by the dynamic host control protocol 
(DHCP) server, in the SDP unit, which makes the drive static IP address not affective. 
 
Therefore, you cannot even connect the customer VOP to drives monitored by an SDP.

For drives not monitored by an SDP, use the following procedure to edit the static IP 
address fields:

1. Overwrite the IP address digits with the specified new digits.

A check mark appears in the Update checkbox.

2. Repeat Step 1 for the Subnet mask

3. Repeat Step 1 for the Gateway

4. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-53 Static IP Address

Parameter Factory Preset Valid Entries

IP address 010.000.000.001 000 - 255 (each 3-digit group)

Subnet mask 255.255.255.000 000 - 255 (each 3-digit group)

Gateway 000.000.000.000 000 - 255 (each 3-digit group)
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▼ To Set the Network Node Name
This text field (FIGURE 4-54) determines the network node name for the T10000 tape 
drive. 

Note – The factory preset default is: t10000 - <last nine digits of drive serial number>.

To set a different network node name:

1. Overwrite the appropriate characters with the specified new characters.

A check mark appears in the Update checkbox.

Note – The factory preset network node name should only be changed by specific 
instructions from your IT manager, or Sun StorageTek Support. 
 
If you use a saved configuration file (from a different drive) to change settings, clear the 
update check box. Otherwise, the network node name will change, which could 
negatively impact network operations.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-54 Node Name
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Save Drive Config Command
The Save Drive Config command (FIGURE 4-55) allows you to save the current drive 
configuration settings to a file. The saved file can then be retrieved to restore drive 
configuration settings.

▼ To Save Drive Config
1. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

2. Click Configure, then choose Save Drive Config.

An typical operating system SaveAs dialog box opens.

3. Select a folder location for the file.

Designate a folder location of your choice.

Note – If a suitable folder does not currently exist, you must cancel the operation; then 
create a new folder, using normal operating system tools. 
 
If you create a new folder, go back to Step 2 to resume this utility.

4. Name the new file.

Use a file name that differentiates it from similar files or overwrite an existing file.

5. Save the file.

The new file is now saved and ready for retrieval with the “Load Drive Config” 
command button, on page 101.

FIGURE 4-55 Save Drive Configuration
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Set Clock Command
The Set Clock command (FIGURE 4-56) allows you to set the drive’s internal clock to the 
current time in your computer. 

Note – The drive clock only operates while the drive is powered on; therefore, the 
drive clock time can fall behind real clock time during times that the drive is not 
powered on.

▼ To Set Clock
1. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

2. Click Configure, then choose Set Cock.

The drive internal clock is set to your computer’s clock.

Note – With VOP release 1.0.9 or lower, there is not any indication of the set clock 
action. Therefore, verify the update by selecting Retrieve>View Date & Time.  
 
With VOP release 1.0.10, and higher, a confirmation text line appears in the transcript 
(see FIGURE 4-57).

FIGURE 4-56 Set Clock

FIGURE 4-57 Set Clock Verification
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Code Load from Tape Command
The Code Load from Tape command (FIGURE 4-58) allows you to update the drive’s 
firmware to the release level contained on a prerecorded Code Load Tape/Cartridge.

Note – You can make a Code Load Tape/Cartridge from a drive that already has the 
updated drive firmware release level active (see “Make Code Tape” on page 83).

▼ To Use Code Load from Tape 
1. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

2. Click Configure, then choose Code Load from Tape.

A text prompt to insert a code load tape appears in the VOP text message pane, and a 
Firmware Update Progress box appears (see FIGURE 4-59).

FIGURE 4-58 Code Load from Tape

FIGURE 4-59 Code Load from Tape Start
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3. Insert the code load tape/cartridge containing the proper firmware release level.

The Firmware Update Progress box (FIGURE 4-60 on page 123) tracks the update.

When the firmware update is completely loaded into the drive memory, the progress 
box disappears, the code load tape/cartridge unloads, and a prompt to remove the 
code load cartridge appears in the VOP text message pane (see FIGURE 4-61).

4. Remove the code load cartridge from the drive load slot.

When the cartridge clears the drive load slot, a drive IPL starts, which will 
load/activate the updated firmware level into the drive RAM.

Note – VOP loses connection to drive during IPL, but automatically reconnects  
once IPL is successfully completed.

5. Select Retrieve>Drive Data>Version tab to verify the updated firmware level.

See FIGURE 4-22 “View Current Drive Settings, Version Tab” on page 95

FIGURE 4-60 Firmware Update Progress

FIGURE 4-61 Code Load from Tape End
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Help Menu 
The Help menu (FIGURE 4-62) has one command that displays information about the 
virtual operator panel, the Java version, and the drive connection. 

1. Click Help, then choose About.

The Drive About Dialog box (FIGURE 4-63) displays information about the VOP 
application; and, if connected to a drive, it lists the drive name and IP address.

2. Click OK to close the dialog box. 

You can also click the X in the upper-right corner of the dialog box.

FIGURE 4-62 Help Menu 

FIGURE 4-63 About Dialogue Box 
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CHAPTER

 

5

VOP Operation - LTO

This chapter provides guidelines for operation of the LTO Virtual Operator Panel (VOP) 
with a single tape drive. See Appendix B for additional guidelines when operating VOP 
within a multiple-drive private network. The VOP does not provide any 
interconnection with the host data input/output interface. 

The VOP application window has three basic operational functions that you access 
from a tab:

■ Drive status monitoring
■ Drive configuration settings
■ Drive diagnosis

The diagnose drive panel also contains a transcript pane where text messages appear 
that relate to both VOP and drive actions.

FIGURE 5-1 LTO-4 Virtual Operator Panel Transcript
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Monitor Drive
The Monitor Drive panel (see the figure below) contains a list of drive, cartridge, and 
Key Management Station agent attributes and values for those attributes.

In addition, the status indicators display the present drive state: 

■ Online state indicator is dark blue - the drive is online

■ Empty state indicator is grey - no cartridge is loaded in the drive 

■ Service state indicator is grey - shows that the Ethernet card (Dione) is 
communicating with the tape drive

■ Encryption state indicator is grey - the drive is not enrolled

FIGURE 5-2 Monitor Drive Panel
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When a cartridge is loaded in the drive, the cartridge state indicator color changes to 
dark blue, the indicator label changes to Loaded, and the Media Type value appears in 
the Monitor Drive panel (the example below indicates an LTO3-formatted cartridge).

FIGURE 5-3 Cartridge Loaded
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Configure Drive
The Configure Drive panel contains five buttons, a Change Enrollment Settings section, 
and a Change IP Settings section.

■ Set Offline - click this button to set the drive offline. When the drive is offline, the 
button label changes to Set Online. Use this button to set the drive to the desired 
state.

■ Enroll - will perform the enrollment after you have entered and committed the 
enrollment parameter settings.

■ IPL - performs an initial program load of the Ethernet (Dione) card.

■ Commit - saves the desired enrollment or IP change in NV RAM (the Dione does not 
reboot if you change the enrollment settings only, but it does reboot when you 
change an IP setting).

■ Cancel - clears all pending change selections.

Enter a value into the appropriate text field to change an enrollment or IP setting. The 
checkbox to the right of the text field will contain a check mark. If you decide against 
an entered change, uncheck the box and the commit operation will ignore that value.

Note – Only those fields with an active check box will be updated when you click the 
Commit button.

FIGURE 5-4 Configure Panel
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The figure below shows that the drive is offline (grey status indicator) and the button 
label in the configure panel has changed to Set Online. Click this button if you want to 
toggle the drive state to online.

FIGURE 5-5 Set Online Button
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Diagnose Drive
The Diagnose Drive panel contains a text-based transcript area and five buttons.

■ Clear Transcript - erases the content from the text pane.

■ Run LED Test - sets the Ethernet (Dione) card in the LED test mode. Press the switch 
on the drive tray (for example, IP Reset on the SL3000 drive tray) and the LED 
flashes.

■ Run Loopback Test - performs an internal loopback test with the LTO-4 drive. 
Results are posted in the text pane.

■ Get Log - saves the Ethernet (Dione) card log file with the name you enter and your 
specified location.

■ Load Firmware - implements the Ethernet card firmware update procedure. You are 
prompted to identify the directory that contains the dione.bin and dione.hdr files.

FIGURE 5-6 Diagnose Drive Tab
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APPENDIX

 

A

Changing the Computer IP Address

This appendix provides guidelines to set a static IP address required to connect to the 
drive, and to reset a single Ethernet port for obtaining a dynamic IP address. 

Note – If your computer has two, or more Ethernet ports, you can dedicate one for 
static IP addressing, and leave the one used to connect to the LAN set for dynamic IP. 

Static IP Address
To connect VOP to a T10000 tape drive that has a static IP address, you must make sure 
your computer has a functional Ethernet port with compatible static IP address.

Note – See your system administrator for Linux/UNIX operating systems.

▼ Setting static IP, Windows OS
Use the following procedure to check/set a static IP address for your computer:

1. Click Start, then select Settings > Network Connections. (FIGURE A-1).

FIGURE A-1 Network Connections Selection
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The Network Connections window (FIGURE A-2) lists all network connections.

2. Double-click the appropriate connection.

The Local Area Connection Properties dialog box (FIGURE A-3) opens.

3. Scroll down to select Internet Protocol (TCP/IP), the click on Properties.

The TCP/IP properties dialogue box (FIGURE A-4 on page 133) opens.

FIGURE A-2 Network Connections Window

FIGURE A-3 Local Area Connection Dialogue Box
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Note – If the port is set for the proper static IP and subnet mask, skip to Step 5. 
Otherwise, perform step 4 to enter/edit the static IP address and subnet mask.

4. Make sure the radio button Use the Use the following IP address is selected, then  
enter a compatible static IP address, Subnet mask, and Default gateway.

See your system administrator, as needed for assistance.

Note – Static IP address 10.0.0.2 is typically used for the computer to be compatible 
with a drive factory preset static IP address 10.0.0.1. However, if the drive’s static IP has 
been customized for your site, you must set the computer’s static IP to be compatible 
with the target drive. The first three digit sets must match, and the last digit set must be 
different from the target drive. The last digit set should also be different than any other 
possible target drive on your site.

5. Click OK.

The Local Area Connection Properties dialogue box (FIGURE A-3 on page 132) reappears. 

6. Click OK.

You can now connect to any on-site drive that has a compatible static IP address.

FIGURE A-4 Internet Protocol (TCP/IP) Properties Dialogue Box
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Dynamic IP Address 
If you set a temporary static IP address for an Ethernet port normally used to connect to 
the LAN, you will need to reset the port to automatically obtain a dynamic IP address. 

▼ Resetting IP to Auto, Windows OS
Use the following procedure to reset a local connection for dynamic IP address: 

1. Click Start, then select Settings > Network Connections (FIGURE A-1 on page 131).

The Network Connections window opens (FIGURE A-2 on page 132).

2. Double-click the Local Area Connection associated with the Ethernet port that 
requires change. 

The Local Area Connection Properties dialogue box (FIGURE A-3 on page 132) opens. 

3. Scroll-down, and select Internet Protocol (TCP/IP), then click on Properties. 

You will need to scroll down as TCP/IP is the last selection. The TCP/IP properties 
dialogue box (FIGURE A-5) opens.

4. Select Obtain an IP address automatically:

The three IP address fields go blank, and become unavailable for entries.
 

5. Click OK to save the reset.

The Local Area Connection Dialogue box (FIGURE A-3 on page 132) reappears. 

6. Click OK.

The Ethernet port is now set to connect to a LAN. 

FIGURE A-5 Internet Protocol (TCP/IP) Properties (auto IP) Dialogue Box
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APPENDIX

 

B

VOP to Drives on Private Networks

This appendix provides supplemental information about VOP to drives connected on a 
private network. 

Private Network, SDP-Controlled
When a Service Delivery Platform (SDP) is present, all monitored drives are connected 
into a private network, controlled by the SDP site server.

The Ethernet port of every monitored drive is 100% dedicated to the service network, 
and each drive has an SDP-controlled dynamic IP address. Therefore, you do not have 
access to the drive Ethernet port and cannot connect your customer-version VOP to 
such drives.

Note – Only Sun StorageTek service representatives are authorized to access drives 
connected to an SDP-controlled private network. Never disconnect an Ethernet cable 
associated with an SDP-controlled private network.  
 
Contact your Sun StorageTek service representative to change drive configuration 
settings of any drive in the SDP-controlled private network.

However, when an SDP site server is not present, your site personnel can interconnect 
drives from one or more drive cabinets into a non-SDP private network. See “Private 
Network, non-SDP” on page 136.
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Private Network, non-SDP
When an SDP site server is not present, a non-SDP private network (FIGURE B-1), can be 
set up, interconnecting the installed drives to one or more cascaded Ethernet switches. 
Such a network allows you to access any connected drive from a central point.

Overview
In a non-SDP, customer-controlled private network, the Ethernet port of each drive is 
connected to an Ethernet switch. A desktop and/or notebook PC, running the 
customer-version VOP application, would also be connected to the network.

Note – Each connected drive and each computer requires an individual static IP 
address. 

FIGURE B-1 Private Network, non-SDP

1. Desktop PC
2. Notebook PC 

3. Ethernet switch
4. T10000 tape drives
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Components
The following components are required to operate VOP in a non-SDP private network:

■ Computer - One or more desktop or notebook computers

Note – The computer must have the customer-version of VOP application installed, 
and an available Ethernet port configured with a compatible static IP address.

■ Ethernet switches - One, or more Ethernet switches might be required to provide one 
port per drive, one port per computer, plus additional ports to cascade multiple 
switches, as needed.

Note – See the Ethernet switch vender documentation for setup guidelines. 

■ Ethernet Cat 5 cables - One cable per drive, one cable per computer, plus additional 
cables to cascade multiple switches, as needed.

Note – Each Ethernet cable must be long enough to connect to the Ethernet switch port 
with enough slack to allow strain relief.

■ Ethernet cross-over cable - One cross-over cable for direct computer-to-drive 
connection.

▼ Setup
See your site IT manager, system administrator, and support personnel to install and 
setup the Ethernet components, and establish the private network static IP address 
scheme. 

Note – Remember, each drive was preset at the factory with the following:  
Static IP address: 010.000.000.001 
Subnet mask: 255.255.255.000  
Default gateway: 000.000.000.000

Use the following procedure to set up each drive for the private network.

1. Set your computer static IP address to 10.0.0.2 and the subnet mask to 255.255.255.0.

See “Static IP Address” on page 131.

2. Start VOP

See Chapter 3, “Starting VOP Programs” on page 61.

3. Connect the Ethernet cross-over cable to the computer Ethernet port and to the drive 
Ethernet port.

4. Connect VOP to the cabled drive.

See “To Use the Connect to Drive Command”.
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5. Reset the drive static IP address.

See “Static IP Address” on page 131

Note – Enter the static IP address designated for the cabled drive.  
 
The VOP does not reconnect to the drive following the IPL because the drive static IP is 
no longer 10.0.0.1.

6. Disconnect the Ethernet cross-over cable at the drive end.

7. Connect the Ethernet cross-over cable to the next drive Ethernet port.

The VOP should automatically connect to the drive because it is still attempting to 
reconnect to IP address 10.0.0.1.

8. Repeat Step 5 through Step 7 for each drive.

When all drives are reset, continue with Step 9.

9. Disconnect the cross-over cable from the computer. 

10. Reset the computer static IP address to the private network-designated IP address.

See “Static IP Address” on page 131.

11. Connect the computer Ethernet port to an available port on the Ethernet switch.

Make sure you use a straight Cat 5 Ethernet cable.

12. Make sure every drive is connected to an Ethernet switch port.

Use a straight Cat 5 Ethernet cable for each drive.

Note – Any drive can be connected to any available Ethernet switch port. It is not 
necessary to assign ports to specific drives. However, you should make a listing of the 
assigned IP address for each drive location.

13. Connect VOP to a selected drive.

See “To Use the Connect to Drive Command”.  
Use the private network-designated drive static IP address.

14. Repeat Step 13 for a few different drives.

Note – You only need to enter the other drive’s designated IP address into the Connect 
to Drive dialog box (FIGURE 4-4 on page 76).

The non-SDP private network is now ready for VOP access to any connected drive.
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Glossary

This glossary defines terms and abbreviations in this publication. 

Some of the definitions are taken from other glossaries. The letters in the parentheses 
that follow some definitions indicate the source of the definition:

(A) The American National Standard Dictionary for Information Systems, ANSI X3.172-1990, 
copyright 1990 by the American National Standards Institute (ANSI).

(E) The ANSI/Electronic Industries Association (EIA) Standard-440-A, Fiber Optic 
Terminology.

(I) The Information Technology Vocabulary, developed by Subcommittee 1, Joint Technical 
Committee 1, of the International Organization for Standardization and International 
Electrotechnical Commission (ISO/IEC/JTC1/SC1).

(IBM) The IBM Dictionary of Computing, copyright 1994 by IBM.

(T) Draft international standards committee drafts, and working papers being 
developed by the ISO/IEC/JTC1/SC1.

A
address A character or group of characters that identifies a register, a particular part of 

storage, or some other data source or destination. (A). 

C
capacity Total amount of User Data stored on one data cartridge in 8 bit bytes. 

Synonymous with “User Capacity” or “Native Capacity”. This is the capacity that 
the user sees after the ECC/Format/ERP etc. overhead has been assessed (no 
compression). 

capacity, raw Total amount of data stored on one data cartridge in 8 bit bytes before any 
ECC/Format/ERP etc. overhead has been assessed (no compression). 

capacity, user Total amount of data stored on one data cartridge in 8 bit bytes that is sent by 
the host computer. This is the capacity that the user sees after the 
ECC/Format/ERP etc. overhead has been assessed (no compression). 



 

140 VOP Customer User’s Guide • June 2008 Revision JA   • 96179

cartridge A storage device that consists of magnetic tape on supply and takeup reels, in a 
protective housing. (IBM)

cleaning cartridge A data cartridge that contains special material to clean the tape path in a 
transport or drive. 

compress To save space by eliminating gaps, empty fields, redundancy, or unnecessary 
data to shorten the length of records or files. (IBM)

configuration The manner in which the hardware and software of an information processing 
system is organized and interconnected. (T)

connector An electrical or optical part that joins two or more other parts.

D
data cartridge A container holding magnetic tape that can be processed without separating the 

tape from the container. 

data security erase (DSE) A random binary pattern, over-writing existing data, from the point of an Erase 
command, to the end-of-tape.

data tape A data cartridge formatted for use as a regular data tape for the system in which 
it is used. 

data track(s) The region(s) of recorded tape containing user data formed as discreet 
longitudinal “tracks” (similar to railroad tracks). 

diagnostics Pertaining to the detection and isolation of errors in programs and faults in 
equipment. (IBM)

drive A device for moving magnetic tape and controlling its movement. (IBM)

dump To copy the contents of all or part of virtual storage to collect error information. 
(IBM)

E
emulation The use of programming techniques and special machine features to permit a 

computing system to execute programs written for another system. (IBM)

EOT End of Tape. 

error A discrepancy between a computed, observed, or measured value or condition 
and the true, specified, or theoretically correct value or condition. (I) (A)

ESD Electrostatic Discharge. 
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F
fault symptom code 

(FSC) A four-character hexadecimal code generated in response to an error to help 
isolate failures within the device. 

FC See fibre channel.

fiber optics The branch of optical technology concerned with the transmission of radiant 
power through fibers made of transparent materials such as glass, fused silica, 
and plastic. (E)

fiber-optic cable A cable made of ultrathin glass or silica fibers which can transmit data using 
pulses of laser light. Fiber-optic cables have several advantages over copper 
cables: they have much less signal loss; they allow information to be transmitted 
at higher speeds and over longer distances; they are not affected by external 
electrical noise; and they are better for transmissions which require security.

fibre channel The National Committee for Information Technology Standards standard that 
defines an ultrahigh-speed, content-independent, multilevel data transmission 
interface that supports multiple protocols simultaneously. Fibre Channel 
supports connectivity to millions of devices over copper and/or fiber-optic 
physical media and provides the best characteristics of both networks and 
channels over diverse topologies.

fibre connection 
(FICON) An ESA/390 and zSeries computer peripheral interface. The I/O interface uses 

ESA/390 and zSeries FICON protocols (FC-FS and FC-SB-2) over a Fibre 
Channel serial interface that configures units attached to a FICON-supported 
Fibre Channel communications fabric.

FICON See fibre connection (FICON). 

FICON channel A channel having a Fibre Channel connection (FICON) channel-to-control-unit 
I/O interface that uses optical cables as a transmission medium. 

file-protect To prevent the erasure or overwriting of data stored on data cartridges.

FIPS Federal Information Processing Standards

FRU Field Replaceable Unit. 

FSC Fault Symptom Code. 

FTP Generic definition: File Transfer Protocol. 

G
GB See gigabyte (GB).

Gb Gigabit, equal to 109 bits.

Gbps Gigabits per second.

gigabyte (GB) One billion (109) bytes. 
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H
hardware All or part of the physical components of an information processing system, 

such as computers or peripheral devices. (T) (A)

hub A Fibre Channel Arbitrated Loop switching device that allows multiple servers 
and targets, such as storage systems, to connect at a central point. A single hub 
configuration appears as a single loop.

I
indicator A device that provides a visual or other indication of the existence of a defined 

state. (T)

interface Hardware, software, or both, that links systems, programs, or devices. (IBM)

internet protocol (IP) A protocol used to route data from its source to its destination in an Internet 
environment. (IBM)

internet protocol (IP) 
address A four-byte value that identifies a device and makes it accessible through a 

network. The format of an IP address is a 32-bit numeric address written as four 
numbers separated by periods. Each number can be from 0 to 255. For example, 
129.80.145.23 could be an IP address.

IP See internet protocol (IP)

L
library A robotic system that stores, moves, mounts, and dismounts data cartridges that 

are used in data read or write operations.

link A physical connection (electrical or optical) between two nodes of a network.

M
menu A list of options displayed to the user by a data processing system, from which 

the user can select an action to be initiated. (T)
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N
network An arrangement of nodes and branches that connects data processing devices to 

one another through software and hardware links to facilitate information 
interchange.

O
offline Neither controlled by, nor communicating with, a computer. (IBM)

online Pertaining to the operation of a functional unit when under the direct control of 
the computer. (T)

P
performance One of two major factors, together with facility, on which the total productivity 

of a system depends. Performance is largely determined by a combination of 
throughput, response time, and availability. (IBM)

R
read/write head The data sensing and recording unit of a diskette magazine drive or tape drive. 

(IBM)

release A distribution of a new product or new function and fixes for an existing 
product. (IBM)

R/W Read/Write.

S
SDP Service Delivery Platform. 

submenu A menu related to and reached from a main menu. (IBM)

sub-system A system that is part of some larger system. 

switch In Fibre Channel technology, a device that connects Fibre Channel devices 
together in a fabric.

system A combination of functionally interrelated interacting mechanical and electrical 
elements designed to work as a coherent entity. 
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T
tape drive A device for moving magnetic tape and controlling its movement. (T)

TCP/IP Transmission Control Protocol/Internet Protocol

transmission control 
protocol/internet protocol 

(TCP/IP) A set of communication protocols that support peer-to-peer connectivity 
functions for both local and wide area networks. (IBM)

V
T10000 Tape Drive

(VOP) A software application that allows a user to monitor and perform some 
operations on a large number of tape drives remotely.

VOLSER VOLume SERial Number. It is, usually 6 characters long and is both the paper 
label stuck on the back edge of the cartridge and in the VOLID label that is 
recorded, particularly by MVS systems, at the beginning of the media. 

volume serial number 
(VOLSER) An alphanumeric label that the host software uses to identify a volume. It 

attaches to the spine of a cartridge and is both human- and machine-readable.

VOP See T10000 Tape Drive (VOP).

W
wrap A single pass of tape from either BOT to EOT or EOT to BOT with the head(s) in 

a fixed transverse location. 

write-enabled A setting on a data cartridge that allows data to be written on the tape.

write-protected A setting on data cartridges that prevents data from being written on the tape. 
Reading data is still possible.
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A
about dialog, VOP 27, 124
Additional Information 20
agreement, internal code 21
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VOP, LTO 28
VOP, T-series 25

B
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clear transcript, ltoVOP 130
configure command, cancel 102
configure command, commit 102
configure command, load drive config 101
configure command, T-series VOP 101
connect, LTO VOP 28
get log, ltoVOP 130
load firmware, ltoVOP 130
run LED test, ltoVOP 130
run loopback test, ltoVOP 130

C
cancel button 102
canceling pending changes 106
changing computer IP address to dynamic 134
clear transcript 75
clear transcript button 130
commit button 102
computer hardware requirements 23
configure

command buttons 101
drive, LTO VOP 128
menu, T-series VOP 100

connect to drive
LTO VOP 28
T-series VOP 76

D
data compression 107
date & time

set 121

view 96
view transcript 96
view, illustration of 96

diagnose drive, LTO VOP 130
download VOP zip folder 32
drive

connect to
LTO VOP 28
T-series VOP 76

Ethernet port, rear panel 73
IPL of T-series 80
status indicators

LTO VOP 28
picture of T-series 26
T-series VOP 26

drive data command 100
drive operations menu 78

force dump 80
format tape 80
IPL drive 80
load tape 79
reset drive 80
set offline 79
set online 79
unload tape 79
zero drive 80

dumps to file 97
dynamic computer address (changing to) 134

E
encrypt tab 87
encryption

reset drive 80
zero drive 80

Ethernet port, drive 73
exit 78

F
fibre tab

view FCP 88
view FICON 89
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file menu 75
clear transcript 75
connect to drive 76
exit 78
illustration 76, 78
overview 75

force dump 80
format tape 80
format tape submenu 81

make code tape 83
make data tape 83
make dump tape 84
rebuild MIR 84

G
get log button 130
Glossary 139

H
hardware requirements 23
help henu

illustration 124
Help Menu 27
help menu 124

about 124
about command 27
overview 27

I
indicators, drive status

LTO VOP 28
T-series VOP 26

installation
JRE software 29
VOP software 32

internal code license 21
Introduction, VOP 23
IPL 80

J
Java Runtime Environment 29

minimum release level requirement 24
JRE 29

K
keyid tab 90

L
language 111
license, internal code 21
load code from file 122
load drive config, button 101
load firmware button 130

load tape 79
logs, retrieve to file 99
LTO VOP

application window 28
clear transcript button 130
configure drive 128
connect button 28
diagnose drive 130
get log button 130
load firmware button 130
monitor drive 126
operation 125
run LED test button 130
run loopback test button 130

M
make code tape 83
make data tape 83
make dump tape 84
manual organization 19
manufacturing tab 91
menu

configure 100
drive operations 78
file 75
help 27, 124
retrieve 85

messages, operator panel display 111
missing tab 92
monitor drive, LTO VOP 126

N
network tab

configure 117
view 93

O
operating system certification 24
operation

LTO VOP 125
T-series VOP 73

organization of this manual 19

P
perms to file 98
Preface 19
prerequisites 23

hardware 23
Java 24
operating system 24

private networks
overview, non-SDP 136
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R
rear panel Ethernet port 73
rebuild MIR 84
requirements, VOP

hardware 23
Java Runtime Environment 24
operating system 24

reset drive 80
retrieve menu 85

picture of 85
view data & time transcript 96
view date & time 96
view date & time illustration 96
view drive data 86

RFID tab 94
run LED test button 130
run loopback test button 130

S
save drive configuration 120
set clock 121
set offline 79
set online 79
software installation

JRE 29
VOP 32

Sun Web site 20

T
tape cartridge write-protect switch 82
translated messages 111

U
unload tape 79

V
version tab 95
view current drive settings

encrypt tab 87
fibre tab (FCP) 88
fibre tab (FICON) 89
keyid tab 90
manufacturing tab 91
missing tab 92
network tab 93
RFID tab 94
version tab 95

view drive data 86
VOP

application window
LTO 28
T-series 25

indicator buttons 26
installation

Linux/Unix OS 50
Windows OS 33

Introduction 23
LTO

application window 28
configure drive 128
diagnose drive 130
monitor drive 126

operation
LTO 125
menu bar 75
T-series 73

VOP application software installation 32
VOP operation

ethernet connection 24
menus

configure 100
drive operations 78
help 124
retrieve 85

menus and controls 74
start

desktop shortcut 65
programs list 63
run dialog box 64

W
world wide name 112
write-protect switch, tape cartridge 82

Z
zero drive 80
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